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Introduction

IBM® Predictive Maintenance and Quality uses data from multiple sources to give
you the information that you need to make informed operational, maintenance,
repair, or component replacement decisions.

IBM Predictive Maintenance and Quality provides you with operational
intelligence data, which enables you to perform the following tasks:
v Understand, monitor, predict, and control product and process variability.
v Perform in-depth root cause failure analysis.
v Identify incorrect operating practices.
v Enhance equipment and process diagnostics capabilities.

It also provides you with asset performance management capabilities that help you
to achieve these goals:
v Have forward visibility into equipment and process performance.
v Increase asset uptime.
v Identify safety issues.
v Identify improper maintenance procedures.
v Optimize maintenance intervals and procedures.

Audience

This document is intended to help users install Predictive Maintenance and
Quality.

Finding information

To find documentation on the web, including all translated documentation, access
IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter).

Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products. Some of the
components included in the IBM Predictive Maintenance and Quality solution have
accessibility features. For more information, see Appendix A, “Accessibility
features,” on page 87.

IBM Predictive Maintenance and Quality HTML documentation has accessibility
features. PDF documents are supplemental and, as such, include no added
accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References
to items that are not currently available may be included. No implication of any
future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole
discretion of IBM.

© Copyright IBM Corp. 2013, 2015 vii
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Chapter 1. Predictive Maintenance and Quality

With IBM Predictive Maintenance and Quality, you can monitor, analyze, and
report on information that is gathered from devices. In addition, recommendations
for actions can be generated by Predictive Maintenance and Quality.

IBM Predictive Maintenance and Quality is an integrated solution that you can use
to perform the following tasks:
v Predict the failure of an instrumented asset so that you can prevent costly

unexpected downtime.
v Make adjustments to predictive maintenance schedules and tasks to reduce

repair costs and minimize downtime.
v Quickly mine maintenance logs to determine the most effective repair

procedures and maintenance cycles.
v Identify the root cause of asset failure faster so that you can take corrective

actions.
v Identify quality and reliability issues definitively and in a timely way.

Instrumented assets generate data such as device ID, timestamp, temperature, and
status code. This data can be collected and used with maintenance records and
other data in models that predict when an asset is likely to fail.

Examples of instrumented assets are manufacturing equipment, mining equipment,
drilling equipment, farming equipment, security equipment, cars, trucks, trains,
helicopters, engines, cranes, oil platforms, and wind turbines.

For example, an oil refinery is a system that combines thousands of interlocking
pieces. It is critical that such a system is able to work safely and efficiently. You
can use IBM Predictive Maintenance and Quality to monitor and track the lifecycle
of each piece of the refinery, such as each pipe, pump, compressor, valve, furnace,
turbine, tank, heat exchange unit, and boiler. Reports give you the information to
ensure that you have the necessary parts available and can schedule repairs during
periods of inactivity.

Predictive maintenance

In predictive maintenance, you look for patterns in the usage and environmental
information for equipment that correlate with failures that take place. This
information is used to create predictive models to score incoming new data. You
can predict the likelihood of failure. Scores are generated from this information
that give you an indication of the health of the piece of equipment. In addition,
key performance indicators (KPIs) are collected, which are used for reporting. KPIs
help you to identify assets that do not conform to normal patterns of behavior. You
can define rules to generate recommendations when a piece of equipment is
identified as having a high probability of failure. Recommendations can be fed into
other systems so that people are alerted to them automatically.

Predictive quality in manufacturing

Past operations data, environmental data, and historical defect data can be used to
identify the causes of elevated defect rates. This information is used in predictive
models, so that when incoming data is fed into the models, you can predict the

© Copyright IBM Corp. 2013, 2015 1



likely defect rates. The predicted values are then used for analysis and reporting
and to drive recommendations such as modification to inspection patterns, or
recalibration of machinery. Scoring can be done on a near real-time basis.

Predictive Maintenance and Quality can also detect quality and reliability problems
faster than traditional techniques.

Single-server installation
In a single-server IBM Predictive Maintenance and Quality installation, the
components for each node are installed to the same computer. But, each node is
configured to run on a separate WebSphere® Application Server profile.

For example, the Business Intelligence (BI) node is installed to a WebSphere
Application Server profile that is named COGNOSProfile that is using port number
9080. Whereas the Predictive Analytics node components are installed to a
WebSphere Application Server profile that is named SPSSProfile that is using port
number 9082. Each profile is running on the same WebSphere Application Server
instance.

The following table lists the port numbers for each WebSphere Application Server
instance:

Table 1. Port numbers for WebSphere Application Servers

Component Admin port SSL admin port Application port

Business Intelligence
(BI) node

9060 9040 9080

PMQ Foundation UI 9061 9041 9081

IBM SPSS 9062 9042 9082

MDM 9063 9043 9083

Important: A single-server installation should be used only for a test or
demonstration environment.

Multiple-server installation
In a multiple-server installation, each IBM Predictive Maintenance and Quality
node provides a specific function for the solution. Each node must be installed on
a separate computer or on a separate virtual machine image from other nodes.

The following diagram shows the nodes in a multiple-server architecture.
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Predictive Analytics node

The Analytics node provides predictive scores and offers recommendations.

This node has the following software installed:
v IBM WebSphere Network Deployment
v IBM SPSS® Collaboration and Deployment Services
v IBM SPSS Modeler Server
v IBM SPSS Data Access Pack
v IBM SPSS Text Analytics Server
v IBM SPSS Modeler Collaboration and Deployment Services Adapter
v IBM SPSS Decision Management
v IBM SPSS Statistics Server
v IBM SPSS Statistics Collaboration and Deployment Services Adapter
v IBM DB2® Client

Figure 1. Predictive Maintenance and Quality nodes
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Business Intelligence (BI) node

The BI node provides dashboards and reports.

This node has the following software installed:
v IBM WebSphere Network Deployment
v IBM HTTP Server
v IBM Cognos® Business Intelligence
v IBM DB2 Client

Integration Bus node

The Integration Bus node processes events, updates the content for IBM Cognos
Business Intelligence, and triggers predictive scoring and decision management. It
also loads master data into the solution.

This node has the following software installed:
v IBM WebSphere MQ
v IBM Integration Bus
v IBM Integration Explorer
v IBM Integration Bus ODBC Database Extender

Master Data Management (MDM) node

The MDM node manages the master data for the solution. The master data
includes the set of devices that supply events to the solution and their locations. It
also includes metadata that is used to determine how events are processed by the
solution.

This node has the following software installed:
v IBM WebSphere Network Deployment
v IBM InfoSphere® Master Data Management Collaboration Edition
v IBM DB2 Client

The MDM node is an optional node for either an Express Deployment or a
Custom Deployment.

If you install the MDM node, the Deployment Wizard will not show all of the
details for the MDM node in the progress messages. For example, the MDM node
will not appear during the IBM DB2 Server Runtime Client deployment task.
Progress messages for the MDM node are shown only during the Master Data
Management deployment task.

data node

The data node provides the database server that contains the databases that are
used by other products in the solution. The database acts as an event store and
holds calculated key performance indicators (KPIs) and profiles. It also contains
supporting master data for the solution.

This node has the following software installed:
v IBM DB2 Enterprise Server Edition

4 IBM Predictive Maintenance and Quality Version 2.5.0: Installation Guide



High-availability installation
You can choose to copy the installation programs for all of the IBM Predictive
Maintenance and Quality component programs to a computer, and then manually
install the components individually.

This option does not install the programs or configure them. The installation and
configuration must be done manually. However, you can use this option to deploy
Predictive Maintenance and Quality if you have specific configuration
requirements that are not available from the single-server or multiple-server
options in the Predictive Maintenance and Quality Deployment Wizard.

Chapter 1. Predictive Maintenance and Quality 5
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Chapter 2. Prerequisites and installation preparation

Before you install IBM Predictive Maintenance and Quality, ensure that the
computers that you use meet the minimum requirements for operating systems,
prerequisite software, processing, and disk space.

You must also install additional prerequisite software on some computers,
including the Business Intelligence (BI) node , the Master Data Management
(MDM) node, and the Integration Bus node computers.

Important: The computers or virtual machines that you use for Predictive
Maintenance and Quality nodes must not have any of the included software
already installed.

Critical installation and configuration issues

To review a list of critical installation and configuration issues for IBM Predictive
Maintenance and Quality version 2.5 as of the date of release, see the document
titled Critical installation and configuration issues for IBM Predictive Maintenance
and Quality version 2.5 (http://www.ibm.com/support/
docview.wss?uid=swg21697299).

Supported operating systems and hardware requirements
Review the minimum hardware and operating system requirements before you
install IBM Predictive Maintenance and Quality. The requirements apply for all
computers or virtual machines that you use for the installation.

For an up-to-date list of environments that are supported by Predictive
Maintenance and Quality, see the IBM Software Product Compatibility Reports
(www.ibm.com/support/docview.wss?uid=swg27041626).

Server computers

The Predictive Maintenance and Quality server components must be installed on
computers that are running the 64-bit Red Hat Enterprise Linux Server Edition
version 6.5 (x86_64) operating system.

You must have the Legacy UNIX compatibility package installed. The package is
selected when the operating system is set up. The components of this package
must be installed on each computer or virtual machine image on which you install
a Predictive Maintenance and Quality node.

Hardware requirements for a multiple server environment

At a minimum, each computer or virtual machine that hosts a Predictive
Maintenance and Quality server component, or node, must have the
following hardware requirements:
v 4 processors
v 8 GB of RAM
v 500 GB of hard disk space

© Copyright IBM Corp. 2013, 2015 7
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The computer from which you run the installation must have sufficient
disk space that is allotted to the / directory. For the computer where you
are running the installation, the minimum recommended disk space for the
/ directory is 150 GB. Each node computer should have a minimum of 100
GB of disk space that is allocated to the / directory.

Important: If you are installing from the universal serial bus (USB) hard
disk drive, you must have 300 GB of disk space allocated to the / directory.

If you are expecting to store large volumes of data, you might need to
increase your disk size.

Each node must be installed on a separate computer or on a separate
virtual machine image.

Hardware requirements for a single-server environment

At a minimum, the computer or virtual machine on which you install
Predictive Maintenance and Quality must have the following hardware
requirements:
v 4 processors
v 8 GB of RAM
v 500 GB of hard disk space

The computer from which you run the installation must have sufficient
disk space that is allotted to the / directory. For the computer where you
are running the installation, the minimum recommended disk space for the
/ directory is 400 GB.

Important: A single-server installation should be used only for a test or
demonstration environment.

User requirements

You must have root or sudo access to all of the computers on which you
install a Predictive Maintenance and Quality node, including the computer
from which you run the installation.

Client computers

The Predictive Maintenance and Quality client components must be installed on
computers that run Microsoft Windows 7 operating systems.

At a minimum, the computer where you run the Deployment Wizard for the client
components must have the following hardware requirements:
v 2 processors
v 4 GB of RAM
v 200 GB of hard disk space

Modifying the sudoers file for the user who runs the
installation

To run the IBM Predictive Maintenance and Quality installation you must be either
root user or have sudo permission on each node computer, and you must disable
requiretty during the installation.

To install with sudo user permissions, you must also add the user to the sudoers
file.
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Procedure
1. Log in as root user.
2. Enter the following command to open the sudoers file for editing:

visudo -f /etc/sudoers

3. Locate the following line:
Defaults requiretty

4. Press the I key to insert text.
5. Type a number sign (#) in front of Defaults requiretty to comment out the

line. For example, the line should appear as
#Defaults requiretty

6. If you run the installer as a user with sudo user permissions, go to the end of
the file, and add the following line for your user:
username ALL=(ALL) NOPASSWD:ALL

7. Press the Esc key, and enter :wq to save and close the file.
8. Repeat these steps on each computer on which you install a Predictive

Maintenance and Quality node.

Installing required operating system packages
Specific operating system packages must be installed on each computer or virtual
machine where you install an IBM Predictive Maintenance and Quality node.

Ensure that the following 32-bit packages are installed:
v libXext-1.1-3.el6.i686.rpm

v libXft-2.1.13-4.1.el6.i686.rpm

v libXi-1.3-3.el6.i686.rpm

v libXp-1.0.0-15.1.el6.i686.rpm

v libXpm-3.5.8-2.el6.i686.rpm

v libXrender-0.9.5-1.el6.i686.rpm

v libXtst-1.0.99.2-3.el6.i686.rpm

v compat-libstdc++-33-3.2.3-69.el6.i686.rpm

v compat-libstdc++-296-2.96-144.el6.i686.rpm

v expat-2.0.1-11.el6_2.i686.rpm

v fontconfig-2.8.0-3.el6.i686.rpm

v freetype-2.3.11-6.el6_2.9.i686.rpm

v libstdc++-4.4.6-4.el6.i686.rpm

v libX11-1.3-2.el6.i686.rpm

v libXau-1.0.5-1.el6.i686.rpm

v libxcb-1.5-1.el6.i686.rpm

v libICE-1.0.6-1.el6.i686.rpm

v libuuid-2.17.2-12.7.el6.i686.rpm

v libSM-1.1.0-7.1.el6.i686.rpm

v libXt-1.0.7-1.el6.i686.rpm

v libXmu-1.0.5-1.el6.i686.rpm

v libjpeg-6b-46.el6.i686.rpm

v libpng-1.2.49-1.el6_2.i686.rpm

v zlib-1.2.3-27.el6.i686.rpm
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v glibc-2.12-1.80.el6.i686.rpm

v openmotif-2.3.3-4.el6.i686.rpm

v libselinux-2.0.94-5.3.el6.i686.rpm

v cracklib-2.8.16-4.el6.i686.rpm

v db4-4.7.25-17.el6.i686.rpm

v audit-libs-2.2-2.el6.i686.rpm

v pam-1.1.1-13.el6.i686.rpm

You can download the packages from a site such as pkgs.org or rpm.pbone.net.

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Type the following command to verify that an operating system package is

installed:
rpm -qi full_package_name

For example, to verify that libXext-1.1-3.el6.i686 is installed, type rpm -qi
libXext-1.1-3.el6.i686.i686.

Note: You might have to use sudo to run the command successfully.
For example, enter sudo rpm -qi full_package_name.

3. Install any package that is not already installed.
You must download any missing package, and then install the downloaded
package by typing the following command:
rpm -ihv full_package_name.rpm

For example, to install libXext-1.1-3.el6.i686, type rpm -ihv
libXext-1.1-3.el6.i686.rpm.

4. Repeat these steps on each computer on which you install a Predictive
Maintenance and Quality node.
If you have yum repositories configured for your Linux operating system
computers, you can use the following command to install all of the
pre-requisite RPMs:
yum -y install compat-libstdc++-296.i686 compat-libstdc++-33.i686
expat.i686 fontconfig.i686 freetype.i686 glibc.i686 libICE.i686
libjpeg.i686 libpng.i686 libSM.i686 libstdc++.i686 libuuid.i686
libX11.i686 libXau.i686 libxcb.i686 libXext.i686 libXft.i686 libXi.i686
libXmu.i686 libXp.i686 libXpm.i686 libXrender.i686 libXt.i686
libXtst.i686 openmotif.i686 zlib.i686 libselinux.i686 cracklib.i686
db4.i686 audit-libs.i686 pam.i686

Verifying that the Legacy UNIX compatibility package is
installed

Legacy UNIX compatibility must be installed on each computer or virtual machine
where you install an IBM Predictive Maintenance and Quality node.

You must verify that the following 64-bit packages are installed:
v authd-1.4.3-30.el6.x86_64.rpm

v cups-lpd-1.4.2-48.el6.x86_64.rpm

v dump-0.4-0.6.b42.el6.x86_64.rpm

v finger-0.17-39.el6.x86_64.rpm

v finger-server-0.17-39.el6.x86_64.rpm
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v krb5-appl-servers-1.0.1-7.el6_2.1.x86_64.rpm

v ksh-20100621-16.el6.x86_64.rpm

v mksh-39-7.el6.x86_64.rpm

v ncompress-4.2.4-54.el6_2.1.x86_64.rpm

v rsh-0.17-60.el6.x86_64.rpm

v rsh-server-0.17-60.el6.x86_64.rpm

v rusers-0.17-61.el6.x86_64.rpm

v rusers-server-0.17-61.el6.x86_64.rpm

v rwho-0.17-34.el6.x86_64.rpm

v talk-0.17-34.el6.x86_64.rpm

v talk-server-0.17-34.el6.x86_64.rpm

v tcp_wrappers-7.6-57.el6.x86_64.rpm

v telnet-0.17-47.el6.x86_64.rpm

v telnet-server-0.17-47.el6.x86_64.rpm

v tftp-0.49-7.el6.x86_64.rpm

v xinetd-2.3.14-34.el6.x86_64.rpm

v compat-expat1-1.95.8-8.el6.x86_64.rpm

v apr-util-1.3.9-3.el6_0.1.x86_64.rpm

v nfs-utils-lib-1.1.5-6.el6.x86_64.rpm

v nfs-utils-1.2.3-39.el6.x86_64.rpm

v nfs4-acl-tools-0.3.3-6.el6.x86_64.rpm

You can download the packages from a site such as pkgs.org or rpm.pbone.net.

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Type the following command to verify that an operating system package is

installed:
rpm -qi full_package_name

For example, to verify that authd-1.4.3-30.el6.x86_64 is installed, type rpm
-qi authd-1.4.3-30.el6.x86_64.

Note: You might have to use sudo syntax to run the command successfully.
For example, enter sudo rpm -qi full_package_name.

3. Install any package that is not already installed.
You must download any missing package, and then install the downloaded
package by typing the following command:
rpm -ihv full_package_name.rpm

For example, to install authd-1.4.3-30.el6.x86_64, type rpm -ihv
authd-1.4.3-30.el6.x86_64.rpm.

4. Repeat these steps on each computer on which you install a Predictive
Maintenance and Quality node.
If you have yum repositories configured for your Linux operating system
computers, you can use the following command to install all of the
pre-requisite RPMs:
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yum -y install authd cups-lpd dump finger finger-server
krb5-appl-servers ksh mksh ncompress rsh rsh-server rusers rusers-server
rwho talk talk-server tcp_wrappers telnet telnet-server tftp xinetd
compat-expat1 apr-util nfs*

Computer firewall settings required for the installation
The Deployment Wizard requires bidirectional communication with each IBM
Predictive Maintenance and Quality node when you install a server component or
server artifact component, and your firewall can interfere with this communication.

To ensure this bidirectional communication, you must configure your firewall
settings for the installation. Alternatively, you can temporarily disable your firewall
during the installation.

Text files that contain the commands you can use to open the ports that are used
by IBM Predictive Maintenance and Quality are provided with the installation. The
Initial-firewall-settings.txt file contains the port information that you must
set before you run the installation. The file is available in the disk1 directory.

Configuring your firewall settings for the Deployment Wizard
On each computer on which you install an IBM Predictive Maintenance and
Quality node, you must open two ports to allow the bidirectional communication
that is required by the Deployment Wizard. After you open the ports in your
firewall, you can then enter these port values in the Deployment Wizard.

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the two ports that are required by the Deployment Wizard with
the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 35000 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 30000 -j ACCEPT

where port 35000 and 30000 are available port numbers on your computers.
You do not have to use these port numbers, but you must use available port
numbers.
If you do not use ports 35000 and 30000, ensure that you change only the port
number values in the commands.

Tip: For consistency, use the same port numbers for each target computer.
4. Type the following command to save your firewall settings:

/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added port should appear in the list.
7. Repeat these steps on each computer on which you install a Predictive

Maintenance and Quality node, and on the computer from where you run the
installation if it is not one of the node computers.
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Configuring your firewall settings for the data node
installation and configuration

Before you install and configure the IBM Predictive Maintenance and Quality data
node, you must ensure that the database server port number is open on the data
node computer.

Procedure
1. Log in to the data node computer as the root user or as a user with sudo

permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the port with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port -j ACCEPT

For example, to open 50000, the default port number for IBM DB2, type the
following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 50000 -j ACCEPT

Note: If you use a port number other than 50000 for your database server,
ensure that you open the appropriate port number.

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for all nodes
On each computer on which you install an IBM Predictive Maintenance and
Quality node, you must open specific ports.

The following ports must be open:
v vnc-server
v x11
v 5901
v 5902
v 5903
v 6001
v 6002
v 6003
v 22

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following commands:
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iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport vnc-server -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport x11 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 5901 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 5902 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 5903 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 6001 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 6002 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 6003 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 22 -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added port should appear in the list.
7. Repeat these steps on each computer on which you install a Predictive

Maintenance and Quality node.

Disabling your computer's firewall during the installation
If you choose to temporarily disable your computer's firewall during the
installation of IBM Predictive Maintenance and Quality, ensure that you enable the
firewall on each node after the installation is complete.

Important: If you disable your computer's firewall during the installation, you
must still ensure that the required ports are opened on each node computer when
you restart your firewall.

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Type the following command:

/etc/init.d/iptables stop

3. Repeat these steps on each computer on which you install a node and on the
server from which you are running the installation.

What to do next

After the installation is complete, on each node, type /etc/init.d/iptables start
to restart your firewall.

Adding each node computer to the hosts file
To ensure that each IBM Predictive Maintenance and Quality node computer can
communicate properly, you must add all node computers to the hosts file on each
node computer.

For example, the hosts file on the data node computer must include the Predictive
Analytics node, the Business Intelligence (BI) node, the Master Data Management
(MDM) node, and the Integration Bus node computers.

Procedure
1. On each node computer, open the /etc/hosts file.
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2. Ensure that each node computer is listed in the file. For example, ensure that
your hosts file contains values such as the following values:
127.0.0.1 localhost.localdomain localhost
##.##.##.## analytics_node_name.domain.com analytics_node_name
##.##.##.## bi_node_name.domain.com bi_node_name
##.##.##.## data_node_name.domain.com data_node_name
##.##.##.## integrationbus_node_name.domain.com integrationbus_node_name
##.##.##.## mdm_node_name.domain.com mdm_node_name

3. Save and close the file.

Generating and copying RSA keys among all node computers
To ensure that each IBM Predictive Maintenance and Quality node computer can
communicate properly, you must generate and copy RSA keys among all of your
node computers.

You must generate the RSA key on the staging server (the server from where you
run the installation). Then, you must copy the RSA keys to each node computer.

Procedure
1. In a terminal window, enter the following command:

ssh-keygen -t rsa

2. Follow the prompts to generate the key. You must provide a file name and a
passphrase.
A public and a private key are generated. The public key has .pub in the file
name.

3. Copy the public key to each node computer, by using the following command:
ssh-copy-id username@node_name

Where node_name is the name or IP address of each node computer.
You must run the command for each node computer. For example,
ssh-copy-id root@analytics_node_name

ssh-copy-id root@bi_node_name

ssh-copy-id root@data_node_name

ssh-copy-id root@integrationbus_node_name

ssh-copy-id root@mdm_node_name

Installing Java on the Predictive Analytics node computer
You must install a Java™ Runtime Environment (JRE) on the computer you use as
the IBM Predictive Maintenance and Quality Analytics node.

You must install Java version 1.7 or later on the Analytics node computer.

Installing Python and PyXML on the Predictive Analytics node
computer

You must install Python and PyXML on the computer you use as the IBM
Predictive Maintenance and Quality Analytics node.

You must install Python version 2.7.1 or later and PyXML version 0.8.4.
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Procedure
1. Log in to the Analytics node computer as the root user or as a user with sudo

permissions.
2. Download and install Python version 2.7.1. You can download the installer

from the Python web site (https://www.python.org/download/releases/2.7.1).
3. Download and install PyXML version 0.8.4. You can download the installer

from the PyXML web site (https://pypi.python.org/pypi/PyXML/0.8.4).

Installing R software on the Predictive Analytics node computer
You must install R and Essentials for R software on the computer you use as the
IBM Predictive Maintenance and Quality Analytics node.

For more information about R and Essentials for R software for IBM SPSS, see the
IBM SPSS documentation (https://www.ibm.com/developerworks/community/
wikis/home?lang=en#!/wiki/We70df3195ec8_4f95_9773_42e448fa9029/page/
Downloads%20for%20IBM%C2%AE%20SPSS%C2%AE%20Statistics).

Procedure
1. Log in to the Analytics node computer as the root user or as a user with sudo

permissions.
2. Download and install R software. You can download the installer from The

Comprehensive R Archive Network website (http://cran.r-project.org).

Installation of Perl on the MDM node computer
You must install a version of Perl on the Master Data Management (MDM) node
computer for IBM Predictive Maintenance and Quality.

In the Deployment Wizard, you are prompted for a location on the MDM node
computer where you installed Perl.

For more information about installing Perl for IBM InfoSphere Master Data
Management, see the MDM documentation (www.ibm.com/support/
knowledgecenter/SSWSR9_11.4.0/com.ibm.pim.ins.doc/
pim_tsk_installingperl.html?cp=SSWSR9_11.4.0%2F1-2-0-1).

Note: For Predictive Maintenance and Quality, the minimum version of Perl is
5.10.

Installing IBM Data Server Driver on the Integration Bus node
computer

Before you can deploy IBM Predictive Maintenance and Quality, you must install
the IBM Data Server Driver for ODBC and CLI on the Integration Bus node
computer.

Procedure
1. Go to the IBM driver and client download page (www.ibm.com/support/

docview.wss?uid=swg21385217).
2. Click the link for IBM Data Server Driver for ODBC and CLI (CLI Driver).
3. If prompted, log in with your IBM account.
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4. Select IBM Data Server Driver for ODBC and CLI (Linux AMD64 and Intel
EM64T).

5. Click Continue, and download the driver.
6. Go to the directory where you downloaded the driver.
7. Type the following command to extract the files:

tar -zxf ibm_data_server_driver_for_odbc_cli_linuxx64_v10.5.tar.gz

The files are extracted to the odbc_cli/clidriver directory.
8. Copy the odbc_cli directory to the var directory to match the default location

in the server installer. For example, ensure the path is /var/odbc_cli.

Ensuring connectivity between the Analytics node and the data node
computers

In IBM Predictive Maintenance and Quality, if the task for configuring the IBM
SPSS Collaboration and Deployment Services displays a database initialization
error, you may have to run the traceroute command to ensure communication
between the Predictive Analytics node and the data node.

Procedure
1. On the Analytics node computer, enter the following command:

traceroute data_node_name

Where data_node_name is the name or IP address of the data node computer.
2. Try the task again.

Setting ulimit values on nodes where WebSphere Application Server is
to be installed

Before you install IBM Predictive Maintenance and Quality, you must ensure that
you have appropriate ulimit values on each node where WebSphere Application
Server is to be installed.

Procedure
1. Log in to the Business Intelligence (BI) node computer as the root user or as a

user with sudo permissions.
a. Go to the /etc/security directory.
b. Open the limits.conf file for editing.
c. Add the following lines to the file:

@root soft nofile 10000
@root hard nofile 16384
* soft nofile 10000
* hard nofile 16384

d. Save and close the file.
e. Restart the computer for the changes to take effect.

2. Log in to the Predictive Analytics node computer as the root user or as a user
with sudo permissions.
a. Go to the /etc/security directory.
b. Open the limits.conf file for editing.
c. Add the following lines to the file:
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@root soft nofile 10000
@root hard nofile 16384
* soft nofile 10000
* hard nofile 16384

d. Save and close the file.
e. Restart the computer for the changes to take effect.

3. Log in to the Master Data Management (MDM) node computer as the root user
or as a user with sudo permissions.
a. Go to the /etc/security directory.
b. Open the limits.conf file for editing.
c. Add the following lines to the file:

@root soft nofile 10000
@root hard nofile 16384
* soft nofile 10000
* hard nofile 16384

d. Save and close the file.
e. Restart the computer for the changes to take effect.

Disabling SELinux on all target computers
You must disable the Security-Enhanced Linux (SELinux) feature on all computers
where you install an IBM Predictive Maintenance and Quality node.

SELinux can be re-enabled after the installation is complete.

Procedure
1. Log on to the computer as the root user or as a user with sudo permissions.
2. Type getenforce and press Enter. The resulting message should say Disabled.
3. If the status is not Disabled, do the following.

a. Go to the /etc/sysconfig directory.
b. Open the selinux file for editing.
c. Change the SELINUX value to disabled.

For example:
SELINUX=disabled

d. Save and close the file.
e. Restart the computer for the changes to take effect.

4. Repeat these steps on each computer on which you install a Predictive
Maintenance and Quality node.

Mounting the USB hard disk drive
The installation files for IBM Predictive Maintenance and Quality are provided on
a universal serial bus (USB) hard disk drive. You can run the installation from the
USB or you can copy the files to your computer before you start the installation.
Before you do either, you must mount the USB hard disk drive.

For more information about mounting USB hard disk drives, see the Red Hat
Customer Portal (https://access.redhat.com/home).
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Chapter 3. Migrate to Predictive Maintenance and Quality
version 2.5

You can migrate your existing IBM Predictive Maintenance and Quality 2.0
environment to version 2.5.

The migration process installs new versions of the software used with Predictive
Maintenance and Quality or applies fix packs to the existing versions of software.
The new versions are installed to the same node computers as you used in your
previous environment. All of the settings that you used are carried over to the 2.5
environment.

For example, WebSphere Application Server is a fix pack that is applied to the
existing version. Whereas, IBM DB2 is a new version. During the migration, the
new version of IBM DB2 is installed to the data node computer, and then a series
of commands are run to copy the settings from your existing version to the new
version. After the migration, the previous version of IBM DB2 will remain on your
computer, but will not be active.

Important: The migration installation process is only for the server components.
The artifacts are not automatically migrated so as not to overwrite any of your
existing content. If you do want the version 2.5 content, you must install it
manually.

Backing up your databases
Before you migrate your IBM Predictive Maintenance and Quality environment,
you must back up your databases.

For more information about backing up your databases, see the IBM DB2
documentation on IBM Knowledge Center (www.ibm.com/support/
knowledgecenter/SSEPGG_10.1.0).

Procedure
1. Log in to the data node computer.
2. Open a terminal window, and change to the database instance owner user. For

example, su - db2inst1.
3. Enter the following commands to back up your Predictive Maintenance and

Quality databases.
a. db2 backup db IBMPMQ

b. db2 backup db COG102DB

c. db2 backup db SPDDSB

d. db2 backup db MDMDB, if you installed the Master Data Management (MDM)
node components.

The databases are backed up to the /home/db2inst1 directory, unless you
specified another directory in the command or you ran the command from a
directory other than the /home/db2inst1 directory.
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Backing up your content and customized files
Before you migrate your IBM Predictive Maintenance and Quality environment,
back up your content files, artifact files, and any customized files on all node
computers.

Stopping the server processes
Before you migrate IBM Predictive Maintenance and Quality, you must stop the
server processes.

Procedure
1. Stop the services on the Business Intelligence (BI) node. For more information,

see “Stopping services on the BI node computer” on page 77.
2. Stop the services on the Master Data Management (MDM) node. For more

information, see “Stopping services on the MDM node computer” on page 77.
3. Stop the services on the Predictive Analytics node. For more information, see

“Stopping services on the Analytics node computer” on page 78.

Starting the Launchpad
Use the Launchpad to start the IBM Predictive Maintenance and Quality
installation or migration.

Before you begin

Ensure that you are logged in as root or a user with sudo permissions.

You must have a Firefox web browser that is installed and set as your default web
browser on the computer from where you run the IBM Predictive Maintenance and
Quality installation. Firefox must be version 17 as a minimum and version 20 at
the latest.

Procedure
1. Go to the directory where you downloaded the installation files.
2. Decompress the installation files. For example, in a terminal window enter tar

-xvf filename.tar.gz or sudo tar -xvf filename.tar.gz.
3. Go to the disk1 directory where you decompressed the files.
4. If you are installing as a user with sudo permissions, enter the following

command to ensure that the Launchpad and Deployment Wizard open
correctly:
export DISPLAY=ipaddress:vncdisplay

where ipaddress is the IP address of the computer where you are running the
installation, and vncdisplay is the VNC display ID for the user who is running
the installation. For example, enter export DISPLAY=127.0.0.1:2

5. If you are installing as a user with sudo permissions, enter the following
command:
xhost +

6. Enter the following command:
./launchpad.sh

Important: Do not enter sudo in front of the command.
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7. Review the information in the Launchpad panels.

Starting a migration
Use the Migrate the Product from 2.0 to 2.5 version option in the Deployment
Wizard to migrate your existing version 2.0 server environment to version 2.5

Procedure
1. Select Migrate the Product from 2.0 to 2.5 version.
2. Click Next.

Validating your target computers
Use the Launchpad to validate that your IBM Predictive Maintenance and Quality
target computers have all of the prerequisite libraries installed.

Validating your target computers is optional. If you do not want to validate your
target computers, select the If you want to skip the validation check box, and
click Next.

Procedure
1. In the Launchpad, click Next until the Validate the Data Node Computer page.
2. Enter the server name of IP address of the data node computer in the

Computer Name box.
a. Enter a user name and password for a user on the target computer in the

User Name and Password boxes.
b. Click Validate Node.
c. If there are any missing prerequisites, use the CheckLib_output.txt file to

help you install or configure the prerequisites, and try the validation again.
The CheckLib_output.txt is in the /var/PMQTemp directory.

d. If the validation succeeds, click Next.
3. Repeat the step for each node computer.

Specifying the target computers for a migration
You must specify the computers on which each IBM Predictive Maintenance and
Quality node is installed.

Before you begin

You must have root access on each computer on which a node is installed.

You might have to change a setting in a configuration file on your target computer
to allow the Deployment Wizard to access the computer as root. Use the
following steps if you receive a message that says the connection to the target
computer was refused:
1. On the target computer, go to the /etc/ssh directory and open sshd_config for

editing.
2. Change the PermitRootLogin property to yes.
3. Save the file, and restart the server for the change to take effect.
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Procedure
1. On the Specify Target Computers pages of the Deployment Wizard, enter the

name or IP address of the computer on which a node is installed in the Target
Computer box.
The Deployment Wizard prompts you for each node computer.
If a node is the computer on which you are running the Deployment Wizard,
enter localhost.

2. Click Add.
When you enter a computer other than localhost, in the Target Computer
Credentials box, do the following steps:
a. Enter the User ID and Password for the root user or a user with sudo

permissions.

Important: Ensure that you enter the credentials for the root user or a user
with sudo permissions on the target computer.

b. Click Test Login.
c. Click Add.

The computer that you entered appears in the Selected target computers
box.

3. Do the following steps if you install if your iptables are running during the
installation.
a. Click Edit > Preferences.
b. Click Target Computer Settings.
c. Select the computer name or IP address in the Target Computer field.
d. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.
e. Enter the Data Port Number that you set in the RMI Registry Port field.

For example, enter 30000.

Note: If you use localhost as a node in the installation, the RMI Registry
Port is unavailable.

4. In the Selected target computers box, select the target computer, and click Test
Connections.

Important: Test Connections tests the connection, tests the credentials, and
locates or enables a deployment agent on the target computer. You must have
an active deployment agent on each target computer.
If you receive an error message after you click Test Connections, you might
have to change some settings on your computers.
v Edit your iptable settings or temporarily disable your firewall. For more

information, see “Computer firewall settings required for the installation” on
page 12.

v Compare and correct your domain name system (DNS) settings for each
computer. For example, type sudo system-config-network. Select DNS
configuration, and ensure that your host name domain and DNS search path
settings are correct.

v Ensure that the /etc/hosts file has the correct entries. For an example, see
“Test Connections validation errors” on page 91.

5. Click Next.
6. Repeat the steps for each computer on which a node is installed.

22 IBM Predictive Maintenance and Quality Version 2.5.0: Installation Guide



Configuring parameters for a migration
Enter the values for your existing IBM Predictive Maintenance and Quality
environment in the Deployment Wizard.

Procedure

Enter values in each field on each page of the Deployment Wizard:

Table 2. IBM DB2 upgrade

Field Default or example value Description

DB2 Server Installation
Directory

/opt/IBM/db2/V10.5 The location where IBM DB2
is to be installed on the data
node computer.

DB2 Server Instance
Password

There is no default value for
this field.

The password for the DB2
instance owner user.

The password cannot contain
more than 8 characters.

DB2 Fenced User Name db2fenc1 The user ID that can run
user-defined functions and
store procedures.

DB2 Instance Owner User
Name

db2inst1 The user ID that controls the
DB2 processes and owns the
directories that are used by
the database instance.

Table 3 includes the configuration parameters for the IBM Integration Bus node.

Table 3. IBM Integration Bus upgrade parameters

Field Default or example value Description

DB2 Client Installation
Directory

/opt/IBM/db2/V10.5 The location where the IBM
DB2 client is to be installed.

DB2 Client Instance User
Name

db2inst1 The user ID for the DB2
client.

IBM Integration Bus
Installation Directory

/opt/IBM/mqsi/9.0.0.1 The location where the
current version of IBM
Integration Bus is installed.

Shared Path Location /var/mqsi/shared-classes

IBM Integration Bus
Installation Directory

/opt/IBM/mqsi/9.0.0.2 The location where the new
version of IBM Integration
Bus is to be installed.

IBM Manufacturing Factory
Pack Install Directory

/opt/IBM/PMQ/Server/
IIBFactoryPack

The location where the IBM
Integration Bus
Manufacturing Pack
components are installed.

Table 4 includes the configuration parameters for the Analytics node computer.

Table 4. Analytics node upgrade parameters

Field Default or example value Description

DB2 Client Installation
Directory

/opt/IBM/db2/V10.5 The location where the IBM
DB2 client is to be installed.
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Table 4. Analytics node upgrade parameters (continued)

Field Default or example value Description

DB2 Client Instance Name db2inst1 The user ID for the DB2
client.

DB2 Client Instance Owner
Name

db2inst1 The user ID for the DB2
client.

DB2 Server Host Name There is no default value for
this field.

The name or IP address of
the data node computer.

DB2 Server Port Number 50000 The port number on which
IBM DB2 server instance is
running.

Database name SPSSDB The name of the SPSS
database.

SPSS Collaboration and
Deployment Services Server
Installation Directory

/opt/IBM/SPSS/Deployment/
6.0/Server

The location where IBM SPSS
Collaboration and
Deployment Services is
installed. This location is on
the Analytics node
computer's file system.

IBM Installation Manager
Installation Directory

/opt/IBM/
InstallationManager/
eclipse/tools/imcl

The location where IBM
Installation Manager is
installed. This directory is on
the Analytics node
computer's file system.

SPSS Collaboration and
Deployment Service Server
Administrative User Name

admin The IBM SPSS Collaboration
and Deployment Services
administrative user.

SPSS Collaboration and
Deployment Service Server
Administrative Password

There is no default value for
this field.

The password for the IBM
SPSS Collaboration and
Deployment Services
administrative user.

SPSS Modeler Server
Installation Directory

/usr/IBM/SPSS/
ModelerServer/16.0

The directory where the IBM
SPSS Modeler Server is
installed. This directory is on
the Analytics node computer.

WebSphere Application
Server Profile Location

/opt/IBM/WebSphere/
AppServer/profiles

The location of the
WebSphere profile. This
directory is on the Analytics
node computer's file system.

WebSphere Application
Server Profile Name

SPSSProfile The name of the WebSphere
profile on the Analytics node
computer.

SPSS Statistics Server
Installation Directory

/opt/IBM/SPSS/
StatisticsServer22

The directory where the IBM
SPSS Statistics Server is
installed. This directory is on
the Analytics node computer.

SPSS Modeler Premium
Solution Publisher
Installation Directory

/opt/IBM/SPSS/
ModelerSolutionPublisher/
16.0

The directory where the IBM
SPSS Modeler Premium
Solution Publisher is
installed. This directory is on
the Analytics node computer.

24 IBM Predictive Maintenance and Quality Version 2.5.0: Installation Guide



Table 4. Analytics node upgrade parameters (continued)

Field Default or example value Description

SPSS Modeler Solution
Publisher Installation
Directory

/usr/IBM/SPSS/
ModelerSolutionPublisher/
16.0

The directory where the IBM
SPSS Modeler Solution
Publisher is installed. This
directory is on the Analytics
node computer.

WebSphere Application
Server Installation Directory

/opt/IBM/WebSphere/
AppServer

The location where
WebSphere Application
Server is installed.

WebSphere Application
Server Profile Server Name

server1 The name of the WebSphere
server.

InfoSphere BigInsights
Enterprise Install Directory

/opt/IBM/PMQ The location where the
InfoSphere BigInsights
installation files are copied.

You must install the product
manually.

ILOG CPLEX Install
Directory

/opt/IBM/PMQ The location where the ILOG
CPLEX installation files are
copied.

You must install the product
manually.

Analytic Server Install
Directory

/opt/IBM/PMQ The location where the
Analytic Server installation
files are copied.

You must install the product
manually.

Table 5 includes the configuration parameters for the Master Data Management
(MDM) node computer.

Table 5. Master Data Management (MDM) node upgrade parameters

Field Default or example value Description

DB2 Client Installation
Directory

/opt/IBM/db2/V10.5 The location where the IBM
DB2 client is to be installed.

DB2 Client Instance Name db2inst1 The user ID for the DB2
client.

DB2 Client Instance Owner
Name

db2inst1 The user ID for the DB2
client.

DB2 Server Host Name There is no default value for
this field.

The name or IP address of
the data node computer.

DB2 Server Port Number 50000 The port number on which
IBM DB2 server instance is
running.

Database name MDMDB The name of the MDM
database.

WebSphere Application
Server Installation Directory

/opt/IBM/WebSphere/
AppServer

The location where
WebSphere Application
Server is installed.
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Table 5. Master Data Management (MDM) node upgrade parameters (continued)

Field Default or example value Description

WebSphere Application
Server Profile Name

MDMProfile The name of the WebSphere
profile on the Master Data
Management (MDM) node
computer.

WebSphere Application
Server Profile Server Name

server1 The name of the WebSphere
server.

Master Data Management
Collaborative Edition
Installation Directory

/opt/IBM/MDM_1 The location where the new
version of MDM is to be
installed.

IBM Installation Tools
location

/opt/IBM/
InstallationManager/
eclipse/tools/imcl

The location where IBM
Installation Manager is
installed. This directory is on
the MDM node computer's
file system.

Provide Master Data
Management 11.0
Installation Directory

/opt/IBM/MDM The location where the
existing version of MDM is
installed.

WebSphere Application
Server MDM Profile
Administrative User Name

admin The administrative user
name for the WebSphere
Application Server MDM
profile.

WebSphere Application
Server MDM Profile
Administrative Password

There is no default value for
this field.

The password for the
administrative user.

Table 6 includes the configuration parameters for the BI node computer.

Table 6. Business Intelligence (BI) node upgrade parameters

Field Default or example value Description

DB2 Client Installation
Directory

/opt/IBM/db2/V10.5 The location where the IBM
DB2 client is to be installed.

DB2 Client Instance Name db2inst1 The user ID for the DB2
client.

DB2 Client Instance Owner
Name

db2inst1 The user ID for the DB2
client.

DB2 Server Host Name There is no default value for
this field.

The name or IP address of
the data node computer.

DB2 Server Port Number 50000 The port number on which
IBM DB2 server instance is
running.

Database name IBMPMQ The name of the reporting
database.

WebSphere Application
Server Installation Directory

/opt/IBM/WebSphere/
AppServer

The location where
WebSphere Application
Server is installed.

WebSphere Application
Server Cognos Profile Name

COGNOSProfile The name of the WebSphere
profile that is used for IBM
Cognos BI.

WebSphere Application
Server Profile Server Name

server1 The name of the WebSphere
server.
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Table 6. Business Intelligence (BI) node upgrade parameters (continued)

Field Default or example value Description

WebSphere Application
Server Profile Template
Directory

/opt/IBM/WebSphere/
AppServer/
profileTemplates/default

The location where the
WebSphere profile templates
are located.

Cognos Business
Intelligence Installation
Directory

/opt/IBM/cognos/c1022_64 The location where IBM
Cognos BI is to be installed.
This directory is on the BI
node computer's file system.

WebSphere Application
Server Profile Directory

/opt/IBM/WebSphere/
AppServer/profiles

The location of the
WebSphere profile. This
directory is on the Analytics
node computer's file system.

Cognos Business
Intelligence Server Host
Name

There is no default value for
this field.

The name or IP address of
the BI node computer.

WebSphere Application
Server PMQ UI Profile User
Name

admin The administrative user
name for the WebSphere
Application Server PMQ UI
profile.

WebSphere Application
Server PMQ UI Profile
Password

There is no default value for
this field.

The password for the
administrative user.

DB2 Server Host Name There is no default value for
this field.

The name or IP address of
the data node computer.

Existing Cognos Business
Intelligence Server
Installation Directory

/opt/IBM/cognos/c10_64 The location where IBM
Cognos BI is installed. This
directory is on the BI node
computer's file system.

IBM WebSphere
Application Server BI Node
Host Name

There is no default value for
this field.

The name or IP address of
the BI node computer.

Cognos Dispatcher
Application Server Port

9080 The HTTP transport port
number for the WebSphere
Application Server where
IBM Cognos is running.

Cognos Content Store
Database Name

COG102CS The IBM Cognos content
store database.

DB2 Database Server
Instance User Name

db2inst1 The user ID that controls the
DB2 processes and owns the
directories that are used by
the database instance.

DB2 Database Server
Instance Password

There is no default value for
this field.

The password for the DB2
instance owner user.

Database Port Number 50000 The port number on which
IBM DB2 server instance is
running.

Database Server Host Name There is no default value for
this field.

The name or IP address of
the data node computer.

WebSphere Application
Server PMQ Foundation UI
Profile Name

PMQUIProfile The name of the WebSphere
profile for the PMQ UI on
the Business Intelligence (BI)
node computer.
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Table 6. Business Intelligence (BI) node upgrade parameters (continued)

Field Default or example value Description

WebSphere Application
Server PMQ UI Profile
Administrative User Name

admin The administrative user
name for the WebSphere
Application Server PMQ UI
profile.

WebSphere Application
Server PMQ UI Profile
Administrative Password

There is no default value for
this field.

The password for the
administrative user.

Migrating content for the MDM node
After the migration is complete, you must manually migrate your content from the
previous version of InfoSphere Master Data Management to the new version. You
migrate the content by running a command.

For more information about migrating MDM, see IBM Knowledge Center
(www.ibm.com/support/knowledgecenter/SSWSR9_11.4.0/com.ibm.pim.mig.doc/
pim_tsk_migratingversions29.html).

Procedure
1. Log in to the Master Data Management (MDM) node as the root user or a user

with sudo permission.
2. In a terminal window, go to the MDM bin/migration directory. For example,

go to /opt/IBM/MDMPIM/bin/migration.
3. Enter the following command:

migratefrom1100.sh

Important: The script must complete with no errors.
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Chapter 4. Server component installation

The installation program installs the required software on each computer that you
identify as an IBM Predictive Maintenance and Quality node. The installation
program can be run from one of the computers that will be a node, or it can be
run from another computer.

For a complete list of products included with Predictive Maintenance and Quality,
see Appendix E, “Supporting programs licensed with IBM Predictive Maintenance
and Quality,” on page 109.

Installation process
With the IBM Predictive Maintenance and Quality installation program, you can
select the individual computers on which each solution node is to be installed and
enter configuration information for each software component.

The diagram shows the installation process being run from one server, the staging
server, and the IBM Predictive Maintenance and Quality components are being
installed to different computers in a multiple server deployment.

In the diagram, the staging server represents the computer from which you run the
installation. In your installation, the staging server can also be used as a node
computer. If you use a separate computer as the staging server, that computer
must also use the same operating system as the other computers on which you
install a node. It must also have the same prerequisites.

Figure 2. IBM Predictive Maintenance and Quality multiple server installation process
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If you are installing Predictive Maintenance and Quality on a single server, you
can install the components to the same computer where you are running the
installation.

Starting the Launchpad
Use the Launchpad to start the IBM Predictive Maintenance and Quality
installation or migration.

Before you begin

Ensure that you are logged in as root or a user with sudo permissions.

You must have a Firefox web browser that is installed and set as your default web
browser on the computer from where you run the IBM Predictive Maintenance and
Quality installation. Firefox must be version 17 as a minimum and version 20 at
the latest.

Procedure
1. Go to the directory where you downloaded the installation files.
2. Decompress the installation files. For example, in a terminal window enter tar

-xvf filename.tar.gz or sudo tar -xvf filename.tar.gz.
3. Go to the disk1 directory where you decompressed the files.
4. If you are installing as a user with sudo permissions, enter the following

command to ensure that the Launchpad and Deployment Wizard open
correctly:
export DISPLAY=ipaddress:vncdisplay

where ipaddress is the IP address of the computer where you are running the
installation, and vncdisplay is the VNC display ID for the user who is running
the installation. For example, enter export DISPLAY=127.0.0.1:2

5. If you are installing as a user with sudo permissions, enter the following
command:
xhost +

6. Enter the following command:
./launchpad.sh

Important: Do not enter sudo in front of the command.
7. Review the information in the Launchpad panels.

Starting an installation
Use the Install and Configure the Product option in the Deployment Wizard to
start the installation.

Procedure

Select Install and Configure the Product.

Validating your target computers
Use the Launchpad to validate that your IBM Predictive Maintenance and Quality
target computers have all of the prerequisite libraries installed.
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Validating your target computers is optional. If you do not want to validate your
target computers, select the If you want to skip the validation check box, and
click Next.

Procedure
1. In the Launchpad, click Next until the Validate the Data Node Computer page.
2. Enter the server name of IP address of the data node computer in the

Computer Name box.
a. Enter a user name and password for a user on the target computer in the

User Name and Password boxes.
b. Click Validate Node.
c. If there are any missing prerequisites, use the CheckLib_output.txt file to

help you install or configure the prerequisites, and try the validation again.
The CheckLib_output.txt is in the /var/PMQTemp directory.

d. If the validation succeeds, click Next.
3. Repeat the step for each node computer.

Starting the Deployment Wizard for the server components
Use the Launchpad to start the IBM Predictive Maintenance and Quality server
Deployment Wizard.

Procedure
1. In the Launchpad, on the Install and Configure page, click one of the

following options:
a. If you are installing as a user with sudo permissions, select Start the

Deployment Wizard as a Sudo User.
v In the Computer Name box, enter the name or IP address of the

computer on which you are running the Deployment Wizard.
v In the VNC Display ID box, enter the display for the user. For example,

enter 1 or 2.
b. If you are installing as root, select Start the Deployment Wizard as the

Root User.
2. Click Start the Predictive Maintenance and Quality Server Deployment.

Setting ports for the Deployment Wizard to use
If you install IBM Predictive Maintenance and Quality components while your
Linux iptables run, you must set the ports that you opened in the Deployment
Wizard.

Procedure
1. In the Deployment Wizard, click Edit > Preferences.

The Deployment Preferences window appears.
2. Enter 30000 in the Data Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 30000.

3. Enter 35000 in the Communication Port Number box.
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Important: Ensure that you enter the port number that you opened if you
selected a port other than 35000.

4. If you use the computer on which you run the installation as a node, do the
following steps:
a. Click Target Computer Settings.
b. Select localhost in the Target Computer field.
c. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.

Note: The RMI Registry Port is unavailable if you use localhost as a node.

Selecting the installation type
You can select an Express Deployment or a Custom Deployment when you install
IBM Predictive Maintenance and Quality. You can also choose to install Predictive
Maintenance and Quality components on different computers or on a single
computer.

An Express Deployment — Multi Node installation uses default settings for all
installed components. You must enter the connection information for each
computer on which a node is installed.

For a Custom Deployment — Multi Node, you can select installation locations,
port numbers, and some component users and their passwords. You must also
enter the information for each computer on which a node is installed. You can also
choose whether to install IBM InfoSphere Master Data Management. This
component is optional for IBM Predictive Maintenance and Quality.

An Express Deployment — Single Node installation uses default settings for all
installed components. You must enter the connection information for one
computer.

Provide the IBM Predictive Maintenance & Quality Stack for High Availability
installation copies the installation programs for each of the server components to
your target computer. After the installation programs are copied, you must install
them individually. The products are not installed and configured for you as with
the express or customer installation options.

Procedure
1. Select one of the following options:

v Express Deployment — Multi Node

v Custom Deployment — Multi Node

v Express Deployment — Single Node

v Provide the IBM Predictive Maintenance & Quality Stack for High
Availability

2. Click Next.
3. If you select Express Deployment — Multi Node or Custom Deployment —

Multi Node, if you do not want to install IBM InfoSphere Master Data
Management, clear that option on the Custom Deployment page.

4. If you select Provide the IBM Predictive Maintenance & Quality Stack for
High Availability, clear the options for each of the product installation
programs that you do not want to copy to your target computers.

5. Click Next.
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Specifying the target computers to install the server components
You must specify a different target computer for each IBM Predictive Maintenance
and Quality node. A node can be installed on a computer or virtual machine, but
each node must be installed on a separate computer or virtual machine.

If you selected Express Deployment — Single Node or Provide the IBM
Predictive Maintenance & Quality Stack for High Availability, you must provide
the connection information for only 1 target computer. The target computer can be
the computer on which you are running the installation.

Before you begin

You must have root access on each computer on which you install a node.

You might have to change a setting in a configuration file on your target computer
to allow the Deployment Wizard to access the computer as root. Use the
following steps if you receive a message that says the connection to the target
computer was refused:
1. On the target computer, go to the /etc/ssh directory and open sshd_config for

editing.
2. Change the PermitRootLogin property to yes.
3. Save the file, and restart the server for the change to take effect.

Procedure
1. On the Specify Target Computers pages of the Deployment Wizard, enter the

name or IP address of the computer on which you install a node in the Target
Computer box.
The Deployment Wizard prompts you for each node computer.
If you install a node on the computer where you run the Deployment Wizard,
you can enter localhost.

2. Click Add.
When you enter a computer other than localhost, in the Target Computer
Credentials box, do the following steps:
a. Enter the User ID and Password for the root user or a user with sudo

permissions.

Important: Ensure that you enter the credentials for the root user or a user
with sudo permissions on the target computer.

b. Click Test Login.
c. Click Add.

The computer that you entered appears in the Selected target computers
box.

3. Do the following steps if you install if your iptables are running during the
installation.
a. Click Edit > Preferences.
b. Click Target Computer Settings.
c. Select the computer name or IP address in the Target Computer field.
d. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.
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e. Enter the Data Port Number that you set in the RMI Registry Port field.
For example, enter 30000.

Note: If you use localhost as a node in the installation, the RMI Registry
Port is unavailable.

4. In the Selected target computers box, select the target computer, and click Test
Connections.

Important: Test Connections tests the connection, tests the credentials, and
locates or enables a deployment agent on the target computer. You must have
an active deployment agent on each target computer.
If you receive an error message after you click Test Connections, you might
have to change some settings on your computers.
v Edit your iptable settings or temporarily disable your firewall. For more

information, see “Computer firewall settings required for the installation” on
page 12.

v Compare and correct your domain name system (DNS) settings for each
computer. For example, type sudo system-config-network. Select DNS
configuration, and ensure that your host name domain and DNS search path
settings are correct.

v Ensure that the /etc/hosts file has the correct entries. For an example, see
“Test Connections validation errors” on page 91.

5. Click Next.
6. Repeat the steps for each computer on which you install a node.

Configuring parameters for a custom deployment of the server
components

The Deployment Wizard displays some default values for each component of IBM
Predictive Maintenance and Quality. You can accept the default values or change
them to suit your environment.

If you are prompted for users, the Deployment Wizard creates the users on the
appropriate target node computer, if they do not exist. For example, IBM DB2
requires a DB2 administrator user, an instance owner user, and a fenced user. Each
of these users is created on the data node computer.

Procedure

Enter values in each field on each page of the Deployment Wizard:
v Click Browse to browse the target computer's file system. It does not browse the

local computer from where you run the Deployment Wizard.
v For some values, such as passwords, default values are not provided. Ensure

that you enter all values on each page of the Deployment Wizard.
v On the Configure IBM DB2 Enterprise Edition page, enter a name for each

database that is to be created by the Deployment Wizard.

Important: You cannot use the same user for the IBM DB2 administrative user
and the instance owner. They must be different users.

Table 7 on page 35 includes the configuration parameters for IBM DB2.
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Table 7. IBM DB2 configuration parameters for a new database server installation

Field Default or example value Description

DB2 Server Installation
Directory

/opt/IBM/db2/V10.5 The location where IBM DB2
is to be installed on the data
node computer.

DB2 Database Port Number 50000 The port number that is used
by IBM DB2.

DB2 Server Administrative
User Name

dasusr1 The user ID that runs the
administration server.

DB2 Server Administrative
Password

There is no default value for
this field.

The password for the user ID
that runs the administration
server.

The password cannot contain
more than 8 characters.

DB2 Server Administrative
Home Directory

/home/dasusr1 The home directory for the
user ID that runs the
administration server. This
directory is on the data node
computer's file system.

DB2 Instance Owner User
Name

db2inst1 The user ID that controls the
DB2 processes and owns the
directories that are used by
the database instance.

DB2 Instance Owner
Password

There is no default value for
this field.

The password for the DB2
instance owner user.

The password cannot contain
more than 8 characters.

DB2 Instance Owner Home
Directory

/home/db2inst1 The home directory for the
DB2 instance owner user.
This directory is on the data
node computer's file system.

DB2 Fenced User Name db2fenc1 The user ID that can run
user-defined functions and
store procedures.

DB2 Fenced Password There is no default value for
this field.

The password for the DB2
instance owner user.

The password cannot contain
more than 8 characters.

DB2 Fenced User Home
Directory

/home/db2fenc1 The home directory for the
DB2 instance owner user.
This directory is on the data
node computer's file system.

Table 8 includes the database names that are created.

Table 8. IBM DB2 configuration parameters: Database names

Field Default or example value Description

SPSS Database Name SPSSDB The SPSS database that is
used by the components that
are installed on the
Predictive Analytics node
computer.

Chapter 4. Server component installation 35



Table 8. IBM DB2 configuration parameters: Database names (continued)

Field Default or example value Description

Cognos Database Name COG102CS The IBM Cognos content
store database.

MDM Database Name MDMDB The Master Data
Management (MDM) node
database.

Table 9 includes the configuration parameters for the IBM DB2 client.

Note: The values apply to all nodes where the IBM DB2 client is installed.

Table 9. IBM DB2 client parameters

Field Default or example value Description

DB2 Client Installation
Directory

/opt/IBM/db2/V10.5 The location where the IBM
DB2 client is to be installed.
This directory is on the
MDM node, Business
Intelligence (BI) node, and
Analytics node computer's
file system.

DB2 Client Instance User
Name

db2inst1 The user ID for the DB2
client.

DB2 Client Instance
Password

There is no default value for
this field.

The password for the DB2
client instance owner user.

DB2 Client Instance Home
Directory

/home/db2inst1 The home directory for the
DB2 client instance owner
user on each node.

Table 10 includes the configuration parameters for WebSphere Application Server.

Table 10. WebSphere Application Server installation parameters

Field Default or example value Description

WebSphere Installation
Directory

/opt/IBM/WebSphere/
AppServer

The location where the
WebSphere Application
Server is to be installed. The
location is the same for each
node where WebSphere is
installed.

Table 11 includes the configuration parameters for IBM HTTP Server.

Table 11. IBM HTTP Server installation parameters

Field Default or example value Description

HTTP Server Installation
Directory

/opt/IBM/HTTPServer The location where IBM
HTTP Server is to be
installed. This directory is on
the BI node computer's file
system.

HTTP Port Number 80 The port number that is used
by HTTP Server.
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Table 11. IBM HTTP Server installation parameters (continued)

Field Default or example value Description

IBM Installation Manager
Installation Directory

/opt/IBM/
InstallationManager/
eclipse/tools/imcl

The location where IBM
Installation Manager is to be
installed. This directory is on
the BI node computer's file
system.

Table 12 includes the installation location for IBM Cognos Business Intelligence.

Table 12. IBM Cognos BI installation parameters

Field Default or example value Description

Cognos BI Installation
Location

/opt/IBM/cognos/c10_64 The location where IBM
Cognos BI is to be installed.
This directory is on the BI
node computer's file system.

Table 13 includes the configuration parameters for the WebSphere Application
Server profile that is used for IBM Cognos Business Intelligence.

Table 13. WebSphere Application Server profile for IBM Cognos BI parameters

Field Default or example value Description

WebSphere Application
Server Profile Directory

/opt/IBM/WebSphere/
AppServer/profiles

The location where the
WebSphere profile is to be
created. This directory is on
the BI node computer's file
system.

Cognos Business
Intelligence Server Host
Name

This value is automatically
entered.

The name or IP address of
the BI node computer.

WebSphere Application
Server Profile Template
Directory

/opt/IBM/WebSphere/
AppServer/
profileTemplates/default

The location where the
WebSphere profile templates
are located.

WebSphere Application
Server Cognos Profile Name

COGNOSProfile The name of the WebSphere
profile that is used for IBM
Cognos BI.

WebSphere Application
Server Cognos Profile
Administrative User Name

admin The administrative user
name for the WebSphere
Application Server profile.

WebSphere Application
Server Cognos Profile
Administrative Password

There is no default value for
this field.

The password for the
administrative user.

Table 14 includes the configuration parameters for the dashboard application that is
installed on the Business Intelligence (BI) node computer.

Table 14. PMQ UI WebSphere Application Server profile parameters

Field Default or example value Description

WebSphere Application
Server Cognos Profile Name

PMQUIProfile The name of the WebSphere
profile that is used for the
dashboard application

WebSphere Application
Server Profile Template
Directory

/opt/IBM/WebSphere/
AppServer/
profileTemplates/default

The location where the
WebSphere profile templates
are located.
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Table 14. PMQ UI WebSphere Application Server profile parameters (continued)

Field Default or example value Description

WebSphere Application
Server PMQ UI Profile User
Name

admin The administrative user
name for the WebSphere
Application Server profile.

WebSphere Application
Server PMQ UI Profile
Password

There is no default value for
this field.

The password for the
administrative user.

Table 15 includes the configuration parameters for IBM Cognos Business
Intelligence.

Table 15. IBM Cognos BI Server parameters

Field Default or example value Description

Database Host Name This value is automatically
entered.

The name or IP address of
the data node computer.

IBM WebSphere
Application Server BI Node
Host Name

This value is automatically
entered.

The name or IP address of
the BI node.

Cognos Dispatcher
Application Server Port

9080 The HTTP transport port
number for the WebSphere
Application Server where
IBM Cognos is running.

Database Server Host Name This value is automatically
entered.

The name or IP address of
the data node.

WebSphere Application
Server Cognos Profile
Administrative User Name

admin The administrative user
name for the WebSphere
Application Server profile.

WebSphere Application
Server Cognos Profile
Administrative Password

There is no default value for
this field.

The password for the
administrative user.

Table 16 includes the configuration parameters for IBM Integration Bus.

Table 16. IBM Integration Bus installation parameters

Field Default or example value Description

WebSphere Message Broker
Explorer Installation
Directory

/opt/IBM/IBExplorer The location where IBM
Integration Explorer is to be
installed. This directory is on
the Integration Bus node
computer's file system.

IBM Integration Explorer
was previously named
WebSphere Message Broker.

Provide the shared classes
path

/var/mqsi The location where the
shared classes used for the
dashboard application are
installed.

IIB Manufacturing Factory
Pack Install Directory

/opt/IBM/PMQ/Server/
IIBFactoryPack

The location where the IBM
Integration Bus
Manufacturing Pack is to be
installed.
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Table 17 includes the configuration parameters for IBM SPSS Collaboration and
Deployment Server.

Table 17. IBM SPSS Collaboration and Deployment Server parameters

Field Default or example value Description

SPSS Collaboration and
Deployment Services Server
Installation Directory

/opt/IBM/SPSS/Deployment/
6.0/Server

The location where IBM SPSS
Collaboration and
Deployment Services is to be
installed. This location is on
the Analytics node
computer's file system.

IBM Installation Manager
Installation Directory

/opt/IBM/
InstallationManager/
eclipse/tools/imcl

The location where IBM
Installation Manager is to be
installed. This directory is on
the Analytics node
computer's file system.

WebSphere Profile Location /opt/IBM/WebSphere/
AppServer/profiles

The location where the
WebSphere profile is to be
created. This directory is on
the Analytics node
computer's file system.

WebSphere Host Name This value is automatically
entered.

The name or IP address of
the Analytics node computer.

SPSS DB2 Database Host
Name

This value is automatically
entered.

The name or IP address of
the data node computer.

SPSS Collaboration and
Deployment Service Server
Administrative Password

There is no default value for
this field.

The password for the IBM
SPSS Collaboration and
Deployment Services
administrative user.

WebSphere Application
Server SPSS Profile
Administrative User Name

admin The IBM SPSS Collaboration
and Deployment Services
administrative user.

WebSphere Application
Server SPSS Profile
Administrative Password

There is no default value for
this field.

The password for the IBM
SPSS Collaboration and
Deployment Services
administrative user.

SPSS Modeler Server
Installation Directory

/usr/IBM/SPSS/
ModelerServer/16.0

The directory where the IBM
SPSS Modeler Server is to be
installed. This directory is on
the Analytics node computer.

SPSS Data Access Pack
Installation Directory

/opt/IBM/SDAP71 The directory where the IBM
SPSS Data Access Pack is to
be installed. This directory is
on the Analytics node
computer.

SPSS Statistics Server
Installation Directory

/opt/IBM/SPSS/
StatisticsServer22

The directory where the IBM
SPSS Statistics Server is to be
installed. This directory is on
the Analytics node computer.

WebSphere Application
Server SPSS Profile
Administrative User Name

admin The IBM SPSS Collaboration
and Deployment Services
administrative user.
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Table 17. IBM SPSS Collaboration and Deployment Server parameters (continued)

Field Default or example value Description

WebSphere Application
Server SPSS Profile
Administrative Password

There is no default value for
this field.

The password for the IBM
SPSS Collaboration and
Deployment Services
administrative user.

SPSS Modeler Premium
Solution Publisher
Installation Directory

/opt/IBM/SPSS/
ModelerSolutionPublisher/
16.0

The directory where the IBM
SPSS Modeler Premium
Solution Publisher is to be
installed. This directory is on
the Analytics node computer.

SPSS Modeler Solution
Publisher Installation
Directory

/opt/IBM/SPSS/
ModelerSolutionPublisher/
16.0

The directory where the IBM
SPSS Modeler Solution
Publisher is to be installed.
This directory is on the
Analytics node computer.

Analytic Server Location /opt/IBM/PMQ The location where the IBM
SPSS Analytic Server
installation files are copied.

To use IBM SPSS Analytic
Server, you must install the
product manually.

InfoSphere BigInsights
Enterprise Install Directory

/opt/IBM/PMQ The location where the IBM
InfoSphere BigInsights™

installation files are copied.

To use IBM InfoSphere
BigInsights, you must install
the product manually.

Table 18 includes the configuration parameters for the IBM Data Server Client on
the Master Data Management (MDM) node computer.

Table 18. IBM Data Server Client parameters

Field Default or example value Description

DB2 Client Installation
Directory

/opt/IBM/db2/V10.5 The location where the IBM
DB2 client is to be installed.
This directory is on the
MDM node computer.

DB2 Client Instance User
Name

db2inst1 The user ID for the DB2
client.

DB2 Client Instance
Password

There is no default value for
this field.

The password for the DB2
client instance owner user.

DB2 Client Instance Home
Directory

/home/db2inst1 The home directory for the
DB2 client instance owner
user on each node.

Table 19 includes the configuration parameters for InfoSphere Master Data
Management.

Table 19. InfoSphere Master Data Management parameters

Field Default or example value Description

WebSphere Installation
Directory

/opt/IBM/WebSphere/
AppServer

The location where
WebSphere Application
Server is to be installed.
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Table 19. InfoSphere Master Data Management parameters (continued)

Field Default or example value Description

MDM Collaboration Server
Installation Directory

/opt/IBM/MDM The location where the
InfoSphere Master Data
Management Collaboration
Server is to be installed.

Master Data Management
Server Name

mdmsvr The server name of the
InfoSphere Master Data
Management Collaboration
Server.

WebSphere Application
Server Profile Template
Location

/opt/IBM/WebSphere/
AppServer/
profileTemplates/default

The location for the
WebSphere profile templates.

WebSphere Application
Server Profile Type

Stand-Alone The type of WebSphere
Application Server
installation.

Do not change the default
value.

WebSphere Application
Server Profile Name

MDMProfile The name of the WebSphere
profile that is used for
InfoSphere Master Data
Management.

WebSphere Application
Server Profile Node Name

Node01 The name for the WebSphere
Application Server node on
the MDM node computer.

WebSphere Application
Server Cell Name

Cell01 The name for the WebSphere
Application Server cell on
the MDM node computer.

WebSphere Application
Server Host Name

This value is automatically
entered.

The name or IP address of
the MDM node computer.

WebSphere Application
Server Profile
Administrative User Name

admin The WebSphere Application
Server administrative user
name.

WebSphere Application
Server Profile
Administrative Password

There is no default value for
this field.

The WebSphere Application
Server administrative user
password.

WebSphere Application
Server Profile SOAP Port
Number

8880 The WebSphere Application
Server port number used for
Master Data Management.

Database Server Host Name This value is automatically
entered.

The name or IP address of
the data node computer.

IBM Installation Manager
Path

/opt/IBM/
InstallationManager/
eclipse/tools/imcl

The location where IBM
Installation Manager is to be
installed. This directory is on
the BI node computer's file
system.

Perl Installation Directory /opt/ActivePerl-5.16 The location where you
installed Active Perl.

This location on the MDM
node computer.
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Starting the installation
After you enter all of the required fields in the Deployment Wizard, you can start
the installation and configuration of the IBM Predictive Maintenance and Quality
components.

Procedure

On the Summary Panel of the Deployment Wizard, click Deploy all.
If you choose to deploy the tasks individually, you must click Deploy task for each
task in the order that the tasks appear on the Summary panel.

Note: The time to deploy the software is estimated by the Deployment Wizard.
The actual time required depends on a variety of factors, such as network speed.
In most cases, the deployments will take significantly less time than what is
initially displayed by the Deployment Wizard.

Configure the server components and test the installation
After the installation of the IBM Predictive Maintenance and Quality server
components is complete, you must perform some additional configuration tasks
and then test the installation.

Testing the database installation and configuration
You can test the database installation and configuration by logging in to the IBM
Predictive Maintenance and Quality data node computer and listing the databases
on the server. You can also list the databases available on each node computer
where the IBM DB2 client was installed.

Procedure

Log on to the data node computer.
1. Open a terminal window, and change to the database instance owner user. For

example, su - db2inst1.
2. Enter the following command to list the databases on the computer:

db2 list database directory

The following databases are listed:
v COG102DB

v MDMDB

v SPSSDB

Configuring WebSphere Application Server for IBM Cognos BI
To complete the installation of the IBM Predictive Maintenance and Quality server
components, you must configure properties in IBM WebSphere Application Server
for IBM Cognos Business Intelligence.

Procedure
1. Open a web browser.
2. In the address bar, type the address for the WebSphere Admin Console that

was installed on the BI node computer.
The Admin console address is: http://bi_node_name:9060/ibm/console where
bi_node_name is the name or IP address for the BI node computer.
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3. Enter admin for both the User ID and Password, and click Log in.
4. Expand Servers > Server Types > WebSphere application servers, and click

server1.
5. Under Server Infrastructure, expand Java and Process Management, and click

Process Definition.
6. Under Additional Properties, click Environment Entries.
7. Click LD_LIBRARY_PATH.
8. In the Value box, add the following value to the path:

:/opt/IBM/db2/V10.5/lib32/

This path points to the IBM DB2 32-bit library file libdb2.so.

Important: If you did not use the default installation locations, ensure you use
the paths that you entered.
For example, the Value box, should include the following path:
/opt/IBM/cognos/c10_64/bin64/:/opt/IBM/db2/V10.5/lib32/

9. Click Apply, and then click Save.

Saving your IBM Cognos Configuration settings
You must save the configuration settings in IBM Cognos Configuration before you
can start the IBM Cognos application in WebSphere Application Server for IBM
Predictive Maintenance and Quality.

Procedure
1. Log in to the BI node computer as root.
2. Enter the following command to load the profile that is needed for IBM Cognos

BI, and press Enter:
. ~/.bash_profile

The .bash_profile file contains the environment variables that are needed to
start IBM Cognos Configuration.

3. Go to the /opt/IBM/cognos/c10_64/bin64 directory.
4. Type the following command:

./cogconfig.sh

IBM Cognos Configuration starts.
5. Click File > Save.
6. Close IBM Cognos Configuration.

Important: If you are prompted to start the Cognos Content Database service,
click No.

7. Click File > Exit.

Starting the services on the BI node computer
For IBM Predictive Maintenance and Quality, start the IBM Cognos BI services by
starting the WebSphere Application Server profile.

The WebSphere Application Server profile is automatically started by the
installation. You must restart the profile after you save the IBM Cognos
configurations settings. Restarting the profile starts the IBM Cognos BI services.

The IBM HTTP Server is automatically started by the installation. However, if it
does not start automatically you can start it manually.
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Procedure
1. Log in to the BI node computer as the root user.
2. Go to the WebSphere Application Server Profile Location. For example, go to

the /opt/IBM/WebSphere/AppServer/profiles/COGNOSProfile/bin directory if
you used the default path in the Deployment Wizard.

3. Type ./stopServer.sh server1 to stop WebSphere Application Server.
4. Type ./startServer.sh server1 to start WebSphere Application Server.

It can take several minutes for all of the IBM Cognos services to start for the
first time.

5. If necessary, perform the following steps to start the IBM HTTP Server:
a. Go to the IBM HTTP Server bin directory. For example, go to

/opt/IBM/HTTPServer/bin.
b. Enter the following command:

./apachectl -k start /opt/IBM/HTTPServer/conf/httpd.conf

Setting the password for the mqm user on the Integration Bus
node computer

You must set the password for the mqm user on the Integration Bus node computer
for IBM Predictive Maintenance and Quality.

Procedure
1. Log in to the Integration Bus node computer as the root user or as a user with

sudo permissions.
2. Type the following command:

passwd mqm

3. Enter mqm and the new password.
You do not have to use mqm. It is only a suggestion. If you do use mqm, you will
see a message saying that your password is too weak. But, you can ignore the
message.

Testing the installation of the server components
You can test the installation of the IBM Predictive Maintenance and Quality server
components by accessing some of the component portals.

For example, you can open the IBM Cognos BI portal on the BI node. If the portal
opens, IBM Cognos BI is installed and running. You can also access the SPSS
configuration tool on the Analytics node computer.

Procedure
1. Open a web browser.
2. In the address bar, type the address for the IBM Cognos Content Manager

status page.
The address is http://bi_node_name:9080/p2pd/servlet, where bi_node_name is
the name or IP address for the BI node computer.
The Content Manager status says Running.

3. In the address bar, type the address for the IBM Cognos BI portal.
The address is http://bi_node_name/ibmcognos/, where bi_node_name is the
name or IP address for the BI node computer.

Note: Ensure that you add the trailing / to the URL.
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IBM Cognos Connection appears.
4. In the address bar, type the address for the SPSS administration console.

The address is http://analytics_node_name:9080/config, where
analytics_node_name is the name or IP address for the Analytics node
computer.

Important: If you are using a single node installation of Predictive
Maintenance and Quality, the port number is 9082. For example, the address is
http://analytics_node_name:9082/config.
The SPSS administration console appears.

Starting the Predictive Maintenance and Quality dashboard
application

The Predictive Maintenance and Quality dashboard application provides a single
interface where users can access IBM Cognos Business Intelligence reports, access
the IBM Analytics Solutions Foundation, and view live profile values for a
particular resource.

Procedure

Access the Predictive Maintenance and Quality dashboard application by typing
the following URL:
http://bi_node_name:port_number/PMQDashboard/pmqui
bi_node_name is the name or IP address for the BI node computer.

Computer firewall settings to run the server components
Each IBM Predictive Maintenance and Quality node computer requires certain
ports to be opened for the server components to operate in a multi-computer
solution, and you must configure your firewall settings for each specific node.

Text files that contain the commands you can use to open the ports that are used
by IBM Predictive Maintenance and Quality are provided with the installation. The
Postinstall-firewall-settings.txt file contains the port information that you
must set after the installation is complete so that the components can communicate
with one another. The file is available in the disk1 directory.

Configuring your firewall settings for the Analytics node
computer

You must ensure that certain ports are open on the Predictive Analytics node
computer for IBM Predictive Maintenance and Quality.

The following ports must be open:
v 45088
v 58313
v 28053
v tungsten-https
v glrpc
v corbaloc
v 59356
v 9043
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v 9060

Procedure
1. Log in to the Analytics node computer as the root user or as a user with sudo

permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following commands:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 45088 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 58313 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 28053 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport tungsten-https -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport glrpc -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport corbaloc -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 59356 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9043 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9060 -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for the BI node computer
You must ensure that certain ports are open on the Business Intelligence (BI) node
computer for IBM Predictive Maintenance and Quality.

The following ports must be open:
v 9362
v vrace
v 9663
v corbaloc
v 9043
v glrpc
v http
v tungsten-https
v 9060

Procedure
1. Log in to the BI node computer as the root user or as a user with sudo

permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following commands:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9362 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport vrace -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9663 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport corbaloc -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9043 -j ACCEPT
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iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport glrpc -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport http -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport tungsten-https -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9060 -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for the Integration Bus node
computer

You must ensure that certain ports are open on the Integration Bus node computer
for IBM Predictive Maintenance and Quality.

The following ports must be open:
v boks
v boks_clntd
v boks_servm
v boks_servc
v ibm-mqseries

Procedure
1. Log in to the Integration Bus node computer as the root user or as a user with

sudo permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following commands:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport boks -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport boks_clntd -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport boks_servm -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport boks_servc -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport ibm-mqseries -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for the MDM node computer
You must ensure that certain ports are open on the Master Data Management
(MDM) node computer for IBM Predictive Maintenance and Quality.

The following ports must be open:
v tungsten-https
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v 50498
v 9634
v 9633
v 57537
v 49888
v 53343
v 41950
v 60573
v 43420
v 40187
v netsteward
v corbaloc
v glrpc
v 44152
v 43830
v 39188
v 9043
v 7507
v 49298
v 8881
v cddbp-alt
v 40752
v 50512
v 35086
v bacula-dir
v jetdirect
v 55052
v 32970
v commplex-link
v 37253
v 9060

Procedure
1. Log in to the MDM node computer as the root user or as a user with sudo

permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following commands:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport tungsten-https -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 50498 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9634 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9633 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 57537 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 49888 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 53343 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 41950 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 60573 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 43420 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 40187 -j ACCEPT
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iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport netsteward -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport corbaloc -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport glrpc -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 44152 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 43830 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 39188 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9043 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 7507 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 49298 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 8881 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport cddbp-alt -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 40752 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 50512 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 35086 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport bacula-dir -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport jetdirect -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 55052 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 32970 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport commplex-link -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 37253 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9060 -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for the data node computer
You must ensure that certain ports are open on the data node computer for IBM
Predictive Maintenance and Quality.

The following ports must be open:
v ibm-db2
v db2c_db2inst1

Procedure
1. Log in to the data node computer as the root user or as a user with sudo

permissions.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following commands:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport ibm-db2 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport db2c_db2inst1 -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.
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Configuring NFS mount settings for the Integration Bus node and
Analytics node computers

You must configure network file system (NFS) mounts on the Integration Bus node
and the Predictive Analytics node computers to allow file transfers between these
nodes.

Procedure
1. Log in to the computer as the root user.

Note: You must perform these steps on both the Integration Bus node and
Analytics node computers.

2. Go to the /etc/sysconfig directory, and open the nfs file in a text editor.
3. Add the following lines to the file or uncomment the lines if they already exist

in the file:
RQUOTAD_PORT=875
LOCKD_TCPPORT=32803
LOCKD_UDPPORT=32769
MOUNTD_PORT=892
STATD_PORT=662
STATD_OUTGOING_PORT=2020

4. Save and close the file.
5. Enter the following commands to restart the Linux services. Press Enter after

each command.
service portmap restart
service nfs restart
service rpcsvcgssd restart

6. Open the iptables file in a text editor.
7. Add the following lines to the file before the final LOG and DROP lines in the

RH-Firewall-1-INPUT chain.
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state
NEW -p udp -dport 111 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 111 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 2049 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 32803 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p udp
-dport 32769 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 892 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p udp
-dport 892 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 875 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p udp
-dport 875 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p tcp
-dport 662 -j ACCEPT
-A RH-Firewall-1-INPUT -s 192.168.1.0/24 -m state -state NEW -p udp
-dport 662 -j ACCEPT

8. Save and close the file.
9. Enter the following command to restart the iptables.

service iptables restart
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Chapter 5. Artifact installation

The server artifacts include report content and workflows for IBM Predictive
Maintenance and Quality.

Starting the Deployment Wizard for the server artifacts
Use the Launchpad to start the IBM Predictive Maintenance and Quality server
artifacts Deployment Wizard.

Before you begin

Ensure that you are logged in as root or a user with sudo permissions.

You must have a Firefox web browser that is installed and set as your default web
browser on the computer from where you run the IBM Predictive Maintenance and
Quality installation. Firefox must be version 17 as a minimum and version 20 at
the latest.

Procedure
1. Go to the directory where you downloaded the installation files.
2. Decompress the installation files. For example, in a terminal window enter tar

-xvf filename.tar.gz or sudo tar -xvf filename.tar.gz.
3. Go to the disk1 directory where you decompressed the files.
4. If you are installing as a user with sudo permissions, enter the following

command to ensure that the Launchpad and Deployment Wizard open
correctly:
export DISPLAY=ipaddress:vncdisplay

where ipaddress is the IP address of the computer where you are running the
installation, and vncdisplay is the VNC display ID for the user who is running
the installation. For example, enter export DISPLAY=127.0.0.1:2

5. If you are installing as a user with sudo permissions, enter the following
command:
xhost +

6. Enter the following command:
./launchpad.sh

Important: Do not enter sudo in front of the command.
7. Review the information in the Launchpad panels.
8. Click Deploy Artifacts, and select one of the following options:

a. If you are installing as a user with sudo permissions, select Start the
Deployment Wizard as a Sudo User.
v In the Computer Name box, enter the name or IP address of the

computer on which you are running the Deployment Wizard.
v In the VNC Display ID box, enter the display for the user. For example,

enter 1 or 2.
b. If you are installing as root, select Start the Deployment Wizard as the

Root User.
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9. Click Start Deployment Wizard.

Selecting the installation type for the artifacts
You must select the environment into which you install the IBM Predictive
Maintenance and Quality server artifacts. For example, whether you are using a
mulitple-server or a single-server installation. Also, you must choose whether you
are using Predictive Maintenance and Quality in a production or a non-production
environment.

If you already have Predictive Maintenance and Qualityversion 2.0 installed, you
must manually deploy the version 2.5 server artifacts.

Procedure
1. Select one of the following options:

v Select Use IBM Predictive Maintenance and Quality in a production
environment (Multi-Node) to install the artifacts in a multiple-server,
production environment

v Select Use IBM Predictive Maintenance and Quality in a non-production
environment (Multi-Node) to install the artifacts in a multiple-server,
non-production, test or demonstration environment.

v Select Use IBM Predictive Maintenance and Quality on Single Node in a
non-production environment to install the artifacts to a test or
demonstration environment on a single-server installation.

v Select Existing PMQ 2.0 Customers if you have Predictive Maintenance and
Quality version 2.0 already installed.
The version 2.5 artifacts are deployed to the node computer, and you must
manually deploy the artifacts if you want to use them. The version 2.5
artifacts are not installed to not overwrite any version 2.0 applications that
you are currently using.

2. Click Next.
3. Select the artifacts that you want to install, and click Next.

Setting ports for the Deployment Wizard to use
If you install IBM Predictive Maintenance and Quality components while your
Linux iptables run, you must set the ports that you opened in the Deployment
Wizard.

Procedure
1. In the Deployment Wizard, click Edit > Preferences.

The Deployment Preferences window appears.
2. Enter 30000 in the Data Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 30000.

3. Enter 35000 in the Communication Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 35000.

4. If you use the computer on which you run the installation as a node, do the
following steps:

52 IBM Predictive Maintenance and Quality Version 2.5.0: Installation Guide



a. Click Target Computer Settings.
b. Select localhost in the Target Computer field.
c. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.

Note: The RMI Registry Port is unavailable if you use localhost as a node.

Specifying the target computers on which to install the artifacts
You must specify a computer on which to install the IBM Predictive Maintenance
and Quality artifacts.

Install the server artifacts on the appropriate node computer. For example, install
the database artifacts to the data node computer.

Before you begin

You must have root access on each computer on which you install a node.

You might have to change a setting in a configuration file on your target computer
to allow the Deployment Wizard to access the computer as root. Use the
following steps if you receive a message that says the connection to the target
computer was refused:
1. On the target computer, go to the /etc/ssh directory and open sshd_config for

editing.
2. Change the PermitRootLogin property to yes.
3. Save the file, and restart the server for the change to take effect.

Procedure
1. On the Specify Target Computers pages of the Deployment Wizard, enter the

name or IP address of the computer on which you installed the node you are
prompted for in the Target Computer box.
The Deployment Wizard prompts you for each node computer.
If you installed a node on the computer where you are running the
Deployment Wizard, enter localhost.

2. Click Add.
When you enter a computer other than localhost, in the Target Computer
Credentials box, do the following steps:
a. Enter the User ID and Password for the root user or a user with sudo

permissions.

Important: Ensure that you enter the credentials for the root user or a user
with sudo permissions on the target computer.

b. Click Test Login.
c. Click Add.

The computer that you entered appears in the Selected target computers
box.

3. Do the following steps if you install if your iptables are running during the
installation.
a. Click Edit > Preferences.
b. Click Target Computer Settings.

Chapter 5. Artifact installation 53



c. Select the computer name or IP address in the Target Computer field.
d. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.
e. Enter the Data Port Number that you set in the RMI Registry Port field.

For example, enter 30000.

Note: If you use localhost as a node in the installation, the RMI Registry
Port is unavailable.

4. In the Selected target computers box, select the target computer, and click Test
Connections.

Important: Test Connections tests the connection, tests the credentials, and
locates or enables a deployment agent on the target computer. You must have
an active deployment agent on each target computer.
If you receive an error message after you click Test Connections, you might
have to change some settings on your computers.
v Edit your iptable settings or temporarily disable your firewall. For more

information, see “Computer firewall settings required for the installation” on
page 12.

v Compare and correct your domain name system (DNS) settings for each
computer. For example, type sudo system-config-network. Select DNS
configuration, and ensure that your host name domain and DNS search path
settings are correct.

v Ensure that the /etc/hosts file has the correct entries. For an example, see
“Test Connections validation errors” on page 91.

5. Click Next.
6. Repeat the steps for each node computer.

Configuring parameters for the server artifacts installation
The Deployment Wizard displays some default values for each component. You
can accept the default values or change them to suit your environment.

If you selected the option to Use IBM Predictive Maintenance and Quality on
Single Node in a non-production environment, you are not prompted for any
parameters for the server artifact installation.

Procedure
1. Use the following table to verify or enter values in each field on each page of

the Deployment Wizard.
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Table 20. data node parameters

Field Default or example value Description

Data Node Deployment
Location

/opt/IBM/PMQ/Data The location where the
server artifacts are to be
installed on the data node
computer.

The artifacts are deployed to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/
Datadateandtime

DB2 Instance Owner User
Name

db2inst1 The user ID that controls the
DB2 processes and owns the
directories that are used by
the database instance.

DB2 Instance Owner
Password

There is no default value for
this field.

The password for the DB2
instance owner user.
Note: Ensure that you use
the same password as you
provided during the server
installation.

Table 21. Integration Bus node parameters

Field Default or example value Description

Install Location of IIB /opt/IBM/mqsi/9.0.0.2 The location where IBM
Integration Bus is installed.
This directory is on the
Integration Bus node
computer's file system.

WebSphere Message Queue
Location

/opt/mqm The location where
WebSphere Message Queue
is installed. This directory is
on the Integration Bus node
computer's file system.

DB2 Client Install Location /opt/IBM/db2/V10.5 The location where the IBM
DB2 client is installed on the
Integration Bus node
computer.

Enterprise Service Bus
Deployment Location

/var/PMQ The location where the
server artifacts are to be
installed on the Integration
Bus node computer.

The artifacts are deployed to
the location in a directory
with a date and time stamp.

Cognos Install Location /opt/IBM/cognos/c10_64 The location where IBM
Cognos BI is installed. This
directory is on the BI node
computer's file system.

Broker Name pmqbroker The broker name that you
created.
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Table 21. Integration Bus node parameters (continued)

Field Default or example value Description

Queue Manager Name pmqmanager The Queue Manager name
that you created.

Execution Group 1 pmqgroup1 The name of a group of
message flows that are
assigned to a broker that you
created.

Execution Group 2 pmqgroup2 The name of a group of
message flows that are
assigned to a broker that you
created.

Analytics Node IP There is no default value for
this field.

The IP address of the
Predictive Analytics node
computer.

Analytics Node HTTP
Transport Port

9080 The WebSphere Application
Server port number that is
used on the Analytics node
computer.

DB2 Port Number 50000 The port number that is used
by the IBM DB2 server on
the data node computer.

Database Node IP There is no default value for
this field.

The IP address of the data
node computer.

DB2 Username db2inst1 The user ID that controls the
DB2 processes and owns the
directories that are used by
the database instance.

DB2 Database Server
Instance Password

There is no default value for
this field.

The password for the DB2
instance owner user.
Note: Ensure that you use
the same password as you
provided during the server
installation.

Table 22. Business Intelligence (BI) node parameters

Field Default or example value Description

Business Intelligence
Deployment Location

/opt/IBM/PMQ/BI The location where the
server artifacts are to be
installed on the BI node
computer.

The artifacts are deployed to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/BIdateandtime

Cognos Install Location /opt/IBM/cognos/c10_64 The location where IBM
Cognos BI is installed. This
directory is on the BI node
computer's file system.
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Table 22. Business Intelligence (BI) node parameters (continued)

Field Default or example value Description

WebSphere Install Location /opt/IBM/WebSphere/
AppServer

The location where
WebSphere is installed. This
directory is on the BI node
computer's file system.

DB2 Instance Home
Directory

/home/db2inst1 The home directory of the
database instance owner.

DB2 Client Install Location /opt/IBM/db2/V10.5 The location where the IBM
DB2 client is installed on the
BI node computer.

WebSphere Cognos Profile
Name

COGNOSProfile The WebSphere Application
Server profile name that is
used for IBM Cognos
Business Intelligence.

Cognos BI Dispatcher URI http://bi_node_name:9080/
p2pd/servlet/dispatch

The URL to the IBM Cognos
BI dispatcher, where
bi_node_name is the name or
IP address of the BI node
computer.

DB2 Database Instance User
Name

db2inst1 The user ID for the IBM
Cognos content store
database.

DB2 Database Instance
Password

There is no default value for
this field.

The password for the
database instance owner
user.

DB2 Database Port Number 50000 The port number for the IBM
DB2 database server.

Database Node IP There is no default value for
this field.

The IP address of the data
node computer.

Integration Bus Node IP There is no default value for
this field.

The IP address of the
Integration Bus node
computer.

WebSphere Application
Server PMQUI Profile
Administrative Username

admin The administrative user
name for the WebSphere
Application Sever profile that
is used for the dashboard
application.

WebSphere Application
Server PMQUI Profile
Administrative Password

There is no default value for
this field.

The password for the
administrative user for the
WebSphere Application Sever
profile that is used for the
dashboard application.

WebSphere Application
Server Cognos Profile
Administrative Username

admin The administrative user
name for the WebSphere
Application Sever profile that
is used for IBM Cognos
Business Intelligence.

WebSphere Application
Server Cognos Profile
Administrative Password

There is no default value for
this field.

The password for the
administrative user for the
WebSphere Application Sever
profile that is used for IBM
Cognos Business Intelligence.
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Table 23. Analytics node parameters

Field Default or example value Description

Analytics Deployment
Location

/opt/IBM/PMQ/Analytics The location where the
server artifacts are to be
installed on the Analytics
node computer.

The artifacts are deployed to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/
Analyticsdateandtime

Modeler Server Install
Location

/usr/IBM/SPSS/
ModelerServer/16.0

The location where the
Modeler Server is installed.

SPSS Data Pack Installation
Location

/opt/IBM/SDAP71 The directory where the IBM
SPSS Data Access Pack is
installed. This directory is on
the Analytics node computer.

Collaboration and
Deployment Services Install
Location

/opt/IBM/SPSS/Deployment/
6.0/Server

The location where IBM SPSS
Collaboration and
Deployment Services is
installed. This location is on
the Analytics node computer.

Integration Bus Node IP There is no default value for
this field.

The IP address of the
Integration Bus node
computer.

Database Node IP There is no default value for
this field.

The IP address of the data
node computer.

Database Username db2inst1 The user ID for the IBM
Cognos content store
database.

Database Password There is no default value for
this field.

The password for the
database instance owner
user.

Database Port 50000 The port number for the IBM
DB2 database server.

Table 24. Master Data Management (MDM) node parameters

Field Default or example value Description

Master Data Deployment
Location

/opt/IBM/PMQ/MDM The location where the
server artifacts are to be
installed on the MDM node
computer.

The artifacts are deployed to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/
MDMdateandtime
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2. If you are an existing version 2.0 customer, enter the following information in
the Deployment Wizard fields.

Table 25. Parameters for Existing PMQ 2.0 Customer deployment option

Field Default or example value Description

Data Deployment Location /opt/IBM/PMQ/Data The location where the
server artifacts are to be
copied on the data node
computer.

The artifacts are copied to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/
datadateandtime

Integration Bus Deployment
Location

/opt/IBM/PMQ/IIB The location where the
server artifacts are to be
copied on the Integration
Bus node computer.

The artifacts are copied to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/
IIBdateandtime

Business Intelligence
Deployment Location

/opt/IBM/PMQ/BI The location where the
server artifacts are to be
copied on the Business
Intelligence (BI) node
computer.

The artifacts are copied to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/BIdateandtime

Analytics Deployment
Location

/opt/IBM/PMQ/Analytics The location where the
server artifacts are to be
copied on the Analytics node
computer.

The artifacts are copied to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/
Analyticsdateandtime
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Table 25. Parameters for Existing PMQ 2.0 Customer deployment option (continued)

Field Default or example value Description

Master Data Deployment
Location

/opt/IBM/PMQ/MDM The location where the
server artifacts are to be
copied on the Master Data
Management (MDM) node
computer.

The artifacts are copied to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/
MDMdateandtime

Configuring server artifact installation parameters for existing 2.0
customers

If you select the Existing PMQ 2.0 Customer installation option for the server
artifacts, you must provide a location on each IBM Predictive Maintenance and
Quality node computer into which to copy the version 2.5 server artifact files.

The version 2.5 artifacts are deployed to the node computer, and you must
manually deploy the artifacts if you want to use them. The version 2.5 artifacts are
not installed to not overwrite any version 2.0 applications that you are currently
using.

Procedure

If you are an existing version 2.0 customer, enter the following information in the
Deployment Wizard fields.

Table 26. Parameters for Existing PMQ 2.0 Customer deployment option

Field Default or example value Description

Data Deployment Location /opt/IBM/PMQ/Data The location where the
server artifacts are to be
copied on the data node
computer.

The artifacts are copied to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/
datadateandtime
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Table 26. Parameters for Existing PMQ 2.0 Customer deployment option (continued)

Field Default or example value Description

Integration Bus Deployment
Location

/opt/IBM/PMQ/IIB The location where the
server artifacts are to be
copied on the Integration
Bus node computer.

The artifacts are copied to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/
IIBdateandtime

Business Intelligence
Deployment Location

/opt/IBM/PMQ/BI The location where the
server artifacts are to be
copied on the Business
Intelligence (BI) node
computer.

The artifacts are copied to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/BIdateandtime

Analytics Deployment
Location

/opt/IBM/PMQ/Analytics The location where the
server artifacts are to be
copied on the Analytics node
computer.

The artifacts are copied to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/
Analyticsdateandtime

Master Data Deployment
Location

/opt/IBM/PMQ/MDM The location where the
server artifacts are to be
copied on the Master Data
Management (MDM) node
computer.

The artifacts are copied to
the location in a directory
with a date and time stamp.

For example,
/opt/IBM/PMQ/
MDMdateandtime

Starting the installation of the server artifacts
After you enter all of the required fields in the Deployment Wizard, you can start
the installation of the server artifacts.
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Procedure

On the Summary Panel of the Deployment Wizard, click Deploy all.
If you choose to deploy the tasks individually, you must click Deploy task for each
task in the order that the tasks appear on the Summary panel.

Note: The time to deploy the software is estimated by the Deployment Wizard.
The actual time required depends on a variety of factors, such as network speed.
In most cases, the deployments will take significantly less time than what is
initially displayed by the Deployment Wizard.

Complete the configuration of the server components
After you have installed the IBM Predictive Maintenance and Quality server
artifacts, you can complete the configuration of the server components.

Verifying the configuration of IBM SPSS Collaboration and
Deployment Services

To complete the configuration of IBM SPSS Collaboration and Deployment Services
Server, you must verify the URL Prefix value for your environment.

Procedure
1. Open a web browser.
2. In the address bar, type the address for the Collaboration and Deployment

administration console.
The address is http://analytics_node_name:9080/config, where
analytics_node_name is the name or IP address for the Predictive Analytics
node computer.

Important: If you are using a single node installation of Predictive
Maintenance and Quality, the port number is 9082. For example, the address is
http://analytics_node_name:9082/config.

3. Enter the Login name and Password for the administrator user, and click
Login.
The default Login name is admin, and the default Password is admin.

4. On the Configuration panel, under Setup, click URL Prefix.
5. In the URL Prefix box, verify that the address is http://

analytics_node_name:9080, where analytics_node_name is the name or IP
address of the Analytics node computer.

6. If the value is correct, you do not have to complete the remaining steps in this
task.

7. If the value is not correct, enter the name or IP address of the Analytics node
computer, and click Set.

8. Open the WebSphere Administrative Console in your web browser.
The address is http://analytics_node_name:9060/ibm/console, where
analytics_node_name is the name or IP address for the Analytics node
computer. 9060 is the default port number for the WebSphere Administrative
Console.

9. Enter admin for both the User ID and Password, and click Log in.
10. Under Applications > Application Types > WebSphere Enterprise

Applications, select
IBM_SPSS_Collaboration_and_Deployment_Services_5.0, and click Stop.
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11. Select IBM_SPSS_Collaboration_and_Deployment_Services_5.0, and click
Start to restart the application and apply the changes.

Configuring the MDM node
To configure the Master Data Management (MDM) node, you must log in to the
MDM administration console and import content files.

The content files are installed onto the MDM node computer by the Server Artifact
installer. You must copy the content files from the MDM node to a computer where
you have Microsoft Internet Explorer installed.

Procedure
1. Copy the MDM node contents to your Microsoft Windows-based computer

with an FTP client or by using a shared directory.
The contents files are installed to /opt/IBM/PMQ by default on the MDM node
computer. The contents file is named IBMPMQ.zip.

2. In Microsoft Internet Explorer, go to the MDM administration console.
The address is http://mdm_node_name:7507/utils/enterLogin.jsp, where
mdm_node_name is the name or IP address of the MDM node computer.

3. In User name, enter Admin.

Note: These values are case-sensitive.
4. In the Password box, enter trinitron.
5. In the Company box, enter IBMPMQ.
6. Click Login.
7. Click System Administrator > Import Environment.
8. In the Import Company Environment box, browse to and select the

IBMPMQ.zip file that you copied.
9. Click Import.

10. Log out, and log back in to the MDM administration console to ensure that
the import was completed.

Configure the Integration Bus node components
To configure the Integration Bus node components, you must enable remote access
for the queue manager.

Enabling remote access for the queue manager
For IBM Predictive Maintenance and Quality, you must start the queue manager
command line processor to enable remote access to the queue manager.

Procedure
1. In a terminal window, go to the installation_location/mqsi/9.0.0.2/bin

directory. For example, if you installed to the default location, go to the
/opt/IBM/mqsi/9.0.0.2/bin directory.

2. Change to the mqm user. For example, su mqm.
3. Enter the following command to load the profile that is needed for the mqm

user, and press Enter:
. ~/.bash_profile

4. As the mqm user, enter the following command to start the queue manager:
runmqsc queue_manager_name
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For example, to use the default queue manager named pmqmanager, enter:
runmqsc pmqmanager

5. Enter the following lines, and press Enter after each line:
START LISTENER

ALTER QMGR CHLAUTH(ENABLED)

SET CHLAUTH(SYSTEM.BKR.CONFIG) TYPE(ADDRESSMAP) ADDRESS('*')
MCAUSER('mqm')

SET CHLAUTH(SYSTEM.BKR.CONFIG) TYPE(BLOCKUSER) USERLIST('*NOACCESS')

END

Important: The ADDRESS(’*’) value in the command allows connections from
any IP address. Consider restricting the access to a single computer. For more
information about these values, see the WebSphere MQ documentation.

Enabling IBM Maximo Asset Management integration
To enable IBM Maximo® Asset Management integration with IBM Predictive
Maintenance and Quality, you must manually modify configuration files and
deploy the PMQMaximoIntegration.bar file.

Procedure
1. Log on to the Integration Bus node computer as the mqm user.
2. Go to the /var/mqsi/shared-classes/orchestrations directory.
3. To enable IBM Maximo work order creation:

a. Open PMQ_orchestration_definition_measurement.xml in a text editor.
b. Uncomment the second service_invocation_configuration element in the

service adapter section.
c. Save and close the file.

4. To enable IBM Maximo work order updating:
a. Open PMQ_orchestration_definition_maintenance.xml in a text editor.
b. Uncomment the last step element in the file.
c. Save and close the file.

5. Restart the pmqbroker.
a. Go to the /opt/IBM/mqsi/9.0.0.2/bin directory.
b. Enter the following command to stop the broker:

./mqsistop pmqbroker

c. Enter the following command to restart the broker:
./mqsistart pmqbroker

6. Set the URL for IBM Maximo.
a. Go to the /var/PMQ/MQSIFileInput/properties directory.
b. Open the PMQMaximoIntegration.properties file in a text editor.
c. Enter the IP address of the IBM Maximo host computer in the

webServiceURL. For example, change localhost to the IBM Maximo host IP
address.

d. Save and close the file.
7. Update the PMQMaximoIntegration.bar file.

a. Go to the /opt/IBM/mqsi/9.0.0.2/bin directory.
b. Enter the following command:
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./mqsiapplybaroverride -b /var/PMQ/MQSIFileInput/server/
PMQMaximoIntegration.bar -k PMQMaximoIntegration -p
/var/PMQ/MQSIFileInput/properties/PMQMaximoIntegration.properties

8. Deploy the PMQMaximoIntegration.bar file.
a. Go to the /opt/IBM/mqsi/9.0.0.2/bin directory.
b. Enter the following command:

./mqsideploy pmqbroker -e pmqgroup1 -a /var/PMQ/MQSIFileInput/server/
PMQMaximoIntegration.bar
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Chapter 6. Client component installation

There are several client components that are included with IBM Predictive
Maintenance and Quality. You can install the components as you require.

Important: The client components must be installed on computers running the
Microsoft Windows 7 64-bit operating system.

Important: Install the client components only after you successfully install the
server components.

Client components
Client components for IBM Predictive Maintenance and Quality are available to be
installed.

For more information about installing and using the client components, see the
documentation provided with the component.

Important: After the client installation files are copied to your computer, some
paths for the compressed files can be long. You might need to use a decompression
utility other than the one provided by Microsoft Windows to decompress the files.

Database connectivity

IBM Data Server Runtime Client must be installed to enable connectivity to the
databases.

Predictive modeling and decision management

Install the following components so that you can modify or create predictive
models and so that you can perform decision management tasks:
v IBM SPSS Collaboration and Deployment Services Deployment Manager
v IBM SPSS Modeler Client Premium

Optionally, install the following components:
v IBM SPSS Statistics Client
v IBM SPSS Collaboration and Deployment Services Documentation
v IBM Analytical Decision Management Documentation
v IBM SPSS Modeler Premium Documentation

Business intelligence

Install IBM Cognos Framework Manager so that you can modify the reporting
model metadata.

Note: You must install IBM Data Server Runtime Client before you can use IBM
Cognos Framework Manager. Ensure that you restart the computer after you install
the IBM Data Server Runtime Client, and that you catalog the databases before you
use Framework Manager. Framework Manager is a 32-bit application, and requires
the 32-bit IBM Data Server Runtime Client.
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Optionally, install the following components:
v IBM Cognos Business Intelligence Samples
v IBM Cognos Dynamic Query Analyzer
v IBM Cognos for Microsoft Office
v IBM Cognos Lifecycle Manager
v IBM Cognos Software Development Kit
v IBM Cognos Supplementary Languages Documentation

Integration Bus

Install the following components:
v Integration Bus Toolkit
v WebSphere MQ for Windows

Use the Integration Bus Toolkit to create, manage, deploy, and delete message
flows and associated resources in a development environment.

Starting the Launchpad for the client components
Use the IBM Predictive Maintenance and Quality Launchpad to start the
Deployment Wizard.

Procedure
1. Go to the directory where you downloaded the artifacts installation files.
2. Decompress the installation files.
3. Go to the disk1 directory where you decompressed the files.
4. Double-click Launchpad.exe or Launchpad64.exe.

Starting the Deployment Wizard for the client components
Use the Launchpad to start the IBM Predictive Maintenance and Quality server
Deployment Wizard.

Procedure

In the Launchpad, click Install Client > Predictive Maintenance and Quality
Client Accelerator to start the Deployment Wizard.

Changing the temporary location for installation files
The Deployment Wizard uses a temporary directory for installation source files.
You must ensure that you are using a location that has adequate disk space for the
installation source files. If you do not have enough disk space in the default
location, you can change the location.

For example, the default location is . If space is limited on your C drive, you can
change the temporary location to another drive.

The temporary files include jar files that are used during the installation, which
you might want to delete after you complete the installation.
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Procedure
1. In the Deployment Wizard, click Edit > Preferences.

The Deployment Preferences window appears.
2. In the Deployment Package Path box, select an existing location.
3. Click OK.

Installing the client components
Use the IBM Predictive Maintenance and Quality Deployment Wizard to copy the
client installation files to your computer. You must run each installation program
individually after the client installation files are copied to your computer.

Tip: You might need to adjust your Windows User Access Control (UAC) settings
so that you can run the installation program for the client components.

Procedure
1. On the Select Tasks panel, select whether you want 32- or 64-bit clients

installed, and click Next.
2. Select the clients for which you want to deploy the installation files, and click

Next.
3. Enter a location for each client component installer to be copied to. The default

is C:\IBM\PMQ\.
4. On the Summary Panel, click Deploy all.

Note: The time to deploy the software is estimated by the Deployment
Wizard. The actual time required depends on a variety of factors, such as
network speed. In most cases, the deployments will take significantly less time
than what is initially displayed by the Deployment Wizard.

5. After the client installers are copied to your computer, you must install each
client individually by using its installer.

Installing IBM SPSS Collaboration and Deployment Services
Deployment Manager

You must install IBM SPSS Collaboration and Deployment Services Deployment
Manager to complete the configuration of IBM Predictive Maintenance and Quality.

Install IBM SPSS Collaboration and Deployment Services Deployment Manager on
a computer running the Microsoft Windows 7 operating system.

Procedure
1. Go to the install_location\Client\Analytics\IBM SPSS Collaboration and

Deployment Services Deployment Manager directory.
By default, the install_location is C:\IBM\PMQ\.

2. Decompress the installation files.
3. In the decompressed folder, double-click install.exe to start the IBM SPSS

Collaboration and Deployment Services Deployment Manager installation.
4. Follow the steps in the wizard to install the client component.

For more information about the installation of Deployment Manager, see the
IBM SPSS documentation (www.ibm.com/support/knowledgecenter/
SS69YH_6.0.0).
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Adding a content server connection for IBM SPSS
Collaboration and Deployment Services

You must add a connection to your IBM SPSS Collaboration and Deployment
Services repository in the IBM SPSS Collaboration and Deployment Services
Deployment Manager client.

After you add the connection, the server folder displays in the Content Explorer,
and you can log in to the server.

Procedure
1. On your Microsoft Windows computer, start IBM SPSS Collaboration and

Deployment Services Deployment Manager. For example, click Start >
Deployment Manager.

2. Click File > New > Content Server Connection.
3. In the Connection Name box, enter a name for your Collaboration and

Deployment Services repository.
4. In the Host box, enter the name or IP address of the Predictive Analytics node

computer.
5. In the Port box, enter 9080.

The default port number that is used by the WebSphere Application Server
instance is 9080.

Important: If you are using a single node installation of Predictive
Maintenance and Quality, the port number is 9082.

6. Click Finish.
7. Click the connection name that you created.
8. In the User ID box, enter admin.
9. In the Password box, enter admin.

10. Click OK.

Adding users and groups to IBM SPSS Collaboration and
Deployment Services

You use IBM SPSS Collaboration and Deployment Services Deployment Manager
to manage users and groups. You must add an administrator user for IBM
Predictive Maintenance and Quality.

Procedure
1. In Deployment Manager, click Tools > Server Administration.
2. Click Click here to define a new administrative server connection.
3. In the Name box, enter a name for your server, and click Next.
4. In the Host box, enter the name or IP address of Predictive Analytics node

computer.
5. In the Port box, enter the port number of for the WebSphere instance. The

default value is 9080.

Important: If you are using a single node installation of Predictive
Maintenance and Quality, the port number is 9082.

6. Click Finish.
7. Double-click the connection name that you created.
8. In the User ID box, enter admin.
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9. In the Password box, enter admin.
10. Click OK.
11. Expand Users and Groups, and double-click Local User Repository.
12. Select Show all available users/groups.
13. Click New Group.

a. Enter administrator.
b. Select Show all available users.
c. Under Available users, move the admin user to Groups contains users.
d. Click OK.

14. Click New Group.
a. Enter DM Administrator.
b. Select Show all available users.
c. Under Available users, move the admin user to Groups contains users.
d. Click OK.

15. Click New Group.
a. Enter DM Users.
b. Select Show all available users.
c. Under Available users, move the admin user to Groups contains users.
d. Click OK.

16. Double-click Roles.
17. Click New Role.

a. In the Role Name box, enter DM Administrator.
b. Click Select All to add all actions for this user role.
c. Click OK.
d. Select the DM Administrator role, and click Edit Users and Groups.
e. Click Show all available users/groups.
f. Under Available users, move the DM Administrator group to

Users/Groups Assigned to Role.
g. Click OK.

18. Click New Role.
a. In the Role Name box, enter DM User.
b. Click Select All to add all actions for this user role.
c. Click OK.
d. Select the DM User role, and click Edit Users and Groups.
e. Click Show all available users/groups.
f. Under Available users, move the DM Users group to Users/Groups

Assigned to Role.
g. Click OK.

Importing the resource definitions into IBM SPSS
Collaboration and Deployment Services

Predictive Maintenance and Quality resource definitions include credential
definitions, data source definitions, message domains, promotion policies, server
definitions, and server cluster specifications. These resources are required for
running jobs.
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You must import these resource definitions into IBM SPSS Collaboration and
Deployment Services Deployment Manager.

The resource files are installed onto the Predictive Analytics node computer by the
Server Artifact installer. You must copy the content files from the Analytics node to
the computer where you installed Deployment Manager.

Procedure
1. Copy the Analytics node contents to your Windows-based computer by using

either an FTP client or by using a shared directory.
The contents files are installed to /opt/IBM/PMQ by default on the Analytics
node computer.

2. Start Deployment Manager, and select the Content Explorer tab.
3. Right-click Content Repository, and click Import.
4. Browse to and select the pes files from the Analytics node server artifacts.

The artifacts include the following files:
v IBMPMQ_ARMOR_ANALYTICS.pes

v IBMPMQ_INTEGRATED_FEATURE_BASED_ANALYTICS.pes

v IBMPMQ_MAINTENANCE_ANALYTICS.pes

v IBMPMQ_SENSOR_ANALYTICS.pes

v IBMPMQ_SENSOR_FEATURE_BASED_ANALYTICS.pes

v IBMPMQ_TOP_FAILURE_PREDICTORS.pes

v IBMPMQ_WARRANTY.pes

5. Click Open.
6. Accept the default options in the Import window, and click OK.
7. Repeat the above steps to import each pes file.

Adding credential definitions to IBM SPSS Collaboration and
Deployment Services

You must add user credential definitions in IBM SPSS Collaboration and
Deployment Services Deployment Manager. You must add the credentials for your
IBM SPSS admin user, the database instance owner, and the root user on the
Predictive Analytics node computer.

About this task

Important:
If any of the users already exist, then you must update the user passwords as
described in this procedure.

Procedure
1. In Deployment Manager, click Content Explorer.
2. Expand Resource Definitions > Credentials.
3. Right-click Credentials, and click New > Credentials Definition.

a. In the Name box, enter admin, and click Next.
b. In the User ID box, enter admin.
c. In the Password box, enter the password you entered for the WebSphere

Application Server Profile Administrative User Name.
d. In the Security Provider box, select Local User Repository.
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e. Click Finish.
4. Right-click Credentials, and click New > Credentials Definition.

a. In the Name box, enter db2inst1, and click Next.
b. In the User ID box, enter db2inst1.
c. In the Password box, enter the password for your db2inst1 user.
d. Leave the Security Provider box blank.
e. Click Finish.

5. Right-click Credentials, and click New > Credentials Definition.
a. In the Name box, enter modeler, and click Next.
b. In the User ID box, enter root.
c. In the Password box, enter the password for the root user on the Analytics

node computer.
d. Leave the Security Provider box blank.
e. Click Finish.

Adding server definitions to IBM SPSS Collaboration and
Deployment Services

You must add server definitions in Deployment Manager.

If you are not using a computer that is running the Microsoft Windows 7 operating
system, some entries, such as server types, may not display correctly.

About this task

Important:
If any of the servers already exist, then you must update their properties as
described in this procedure.

Procedure
1. In Deployment Manager, click Content Explorer.
2. Expand Resource Definitions.
3. Right-click Servers, and click New > Server Definition.

a. In the Name box, enter localhost, and click Next.
b. In the Type box, select Content Repository Server.
c. Click Next.
d. In the Host box, enter the name or IP address of Analytics node computer.
e. In the Port box, enter 9080.

Important: If you are using a single node installation of Predictive
Maintenance and Quality, the port number is 9082.

f. Click Finish.
4. Right-click Servers, and click New > Server Definition.

a. In the Name box, enter modeler, and click Next.
b. In the Type box, select Modeler Server.
c. Click Next.
d. In the Host box, enter the name or IP address of Analytics node computer.
e. In the Port box, enter 28053.
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f. In the Default data path box, enter the path to the data directory on
Analytics node computer. For example, enter /usr/IBM/SPSS/ModelerServer/
16.0/demos

g. Click Finish.

Installation of the Integration Bus clients
For IBM Predictive Maintenance and Quality, you must install MQ Explorer,
Integration Toolkit, and Integration Explorer.

Installing MQ Explorer
IBM Integration Explorer client application requires that MQ Explorer is installed
on the same computer.

Procedure
1. Go to the install_location\Client\Integration Bus\IBM Integration Bus

directory.
By default, the install_location is C:\IBM\PMQ\.

2. Decompress the installation file that is named
IIB_IBToolkit_WS_MQ_WINDOWS_X86-64.zip.

3. In the decompressed directory, go to the integrationbus\
WebSphere_MQ_V7.5.0.1 directory, and double-click MQLaunch.exe.

4. Click Software Requirements, and ensure that you are using a supported
operating system.

5. Click Network Configuration, and select No for Configuring WebSphere MQ
for Windows domain users.

6. Click WebSphere MQ Installation, and click Launch IBM Websphere MQ
Installer.

7. On the Setup Type page, select Custom, and click Next.
8. On the Features page, select only MQ Explorer to be installed.

Ensure that all other features are set to Do not install this feature.
9. Click Next.

10. Click Install, and click Finish.

Installing the Integration Bus client applications
Install the IBM Predictive Maintenance and Quality Integration Bus client
applications. The applications include IBM Integration Toolkit and IBM Integration
Explorer.

Before you begin

Ensure that MQ Explorer is already installed.

Procedure
1. Go to the directory where you decompressed the Integration Bus client

application installers.
2. In the decompressed directory, in the integrationbus directory, double-click

mqsilaunchpad.exe.
3. Select the check boxes for IBM Integration Toolkit, and IBM Integration

Explorer. Clear the check box for IBM Integration Bus.
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If it is not already installed, IBM Installation Manager is installed with IBM
Integration Toolkit.

4. Click Launch Installation for IBM Integration Bus.
IBM Installation Manager appears.

5. Follow the steps in IBM Installation Manager to install IBM Integration Toolkit.
6. When you are prompted to open a product, select None, and click Finish.

The installer for IBM Integration Explorer appears.
7. Follow the steps in the wizard to install IBM Integration Explorer.

Connecting to your WebSphere MQ broker
Connect to the queue manager you created on the IBM Predictive Maintenance and
Quality Integration Bus node computer.

Procedure
1. In a terminal window, type the following command (all on one line):

setmqaut -m pmqmanager -t queue -n SYSTEM.MQEXPLORER.REPLY.MODEL -g mqm

+browse -get +put

2. From the Start menu, click All Programs > IBM WebSphere MQ >
WebSphere MQ Explorer.
The first time that you start WebSphere MQ Explorer, you are prompted for a
workspace location.

3. In the MQ Explorer - Navigator, under IBM WebSphere MQ, right-click
Queue Managers, and select Add Remote Queue Manager.

4. Enter the name of your queue manager, select Connect directly, and click
Next. For example, enter pmqmanager.

5. In the Connection details section, enter the following information, and click
Next.
a. In the Host name or IP address box, enter the information for your

Integration Bus node computer.
b. In the Port number box, enter the listener port number. The default is

1414.
c. In the Server-connection channel box, enter SYSTEM.BKR.CONFIG

6. On the Specify user identification details page, select Enable user
identification.

7. In the Userid box, enter mqm.
8. The first time that you add a user, you must enable password saving. Click

Passwords Preferences Page, and then select Save passwords to file to enable
the feature, and click OK.

9. Click Enter password.
10. Enter the user's password, and click OK.
11. Click Finish. The queue manager appears in the list, and the status appears as

running.

Installing Framework Manager for IBM Predictive Maintenance and
Quality

Install IBM Cognos Framework Manager to create or edit models and publish
packages for IBM Cognos Business Intelligence.
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Procedure
1. Go to the install_location\Client\Business Intelligence\IBM Cognos

Framework Manager directory.
By default, the install_location is C:\IBM\PMQ\.

2. Decompress fm_10.2.2_win_ml.tar.gz, and then decompress
fm_10.2.2_win_ml.tar.

3. Go to the win32 directory, and double-click the issetup.exe file.
4. Follow the steps in the wizard to install the product.
5. When notified with an information message about installing the

Supplementary Languages Documentation, click OK

6. On the last page of the installation wizard, select Start IBM Cognos
Configuration to configure Cognos Framework Manager.

7. Click Finish.
8. In IBM Cognos Configuration, in the Explorer panel, select Environment.
9. In the Gateway URI value, change localhost to the name or IP address of the

Business Intelligence (BI) node computer.
10. In the Dispatcher URI for external applications value, change localhost to

the name or IP address of the Business Intelligence (BI) node computer.
11. In the Dispatcher URI for external applications value, change 9300 to 9080.

9080 is the port number that is used by WebSphere Application Server for IBM
Cognos Business Intelligence.

12. Click File > Save.

Copying the license files to each client computer
After you install the IBM Predictive Maintenance and Quality client components,
you must copy the swidtag file and license directory from where you installed the
artifacts to the computers on which you install an IBM Predictive Maintenance and
Quality client.

Important: Do not rename the directories or files.

Procedure
1. Copy the swidtag file from the iso-swid directory where you installed the

artifacts to each computer on which you install a client.
For example, copy the file so that you have a C:\IBM\PMQ\iso-swid directory
that contains a swidtag file.

2. Copy the license directory from the directory where you installed the artifacts
to each computer on which you install a client.
For example, copy the directory and contents so that you have a
C:\IBM\PMQ\license directory that contains the license files.

76 IBM Predictive Maintenance and Quality Version 2.5.0: Installation Guide



Chapter 7. Stop and start solution software services

IBM Predictive Maintenance and Quality is an integrated solution that includes
many products. If you must stop the services, you must do so in the correct order.
The product services must also be started in the correct order.

Stop solution services
Stop the IBM Predictive Maintenance and Quality node services in the following
order:
1. Master Data Management (MDM) node
2. Business Intelligence (BI) node
3. Integration Bus node
4. Predictive Analytics node
5. data node

Stopping services on the MDM node computer
You must stop the services on the Master Data Management (MDM) node before
you stop services on other nodes.

Procedure
1. Log in to the MDM node computer as root.
2. Go to the MDM installation location. For example, go to /opt/IBM/MDMPIM.
3. Go to the /bin/go directory.
4. Enter the following command:

./stop_local.sh

5. Go to the WebSphere Application Server profile directory when MDM is
running. For example, go to /opt/IBM/WebSphere/AppServer/profiles/
MDMProfile/bin.

6. Enter the following command:
./stopServer.sh server1

Stopping services on the BI node computer
You must stop the IBM Cognos Business Intelligence services and IBM HTTP
Server on the IBM Predictive Maintenance and Quality Business Intelligence (BI)
node computer.

You stop the IBM Cognos BI services by stopping the WebSphere Application
Server profile where IBM Cognos BI is running.

Procedure
1. Log in to the BI node computer as root.
2. Go to the WebSphere Application Server profile directory when IBM Cognos BI

is running. For example, go to /opt/IBM/WebSphere/AppServer/profiles/
COGNOSProfile/bin.

3. Enter the following command:
./stopServer.sh server1
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4. Go to the IBM HTTP Server bin directory. For example, go to
/opt/IBM/HTTPServer/bin.

5. Enter the following command:
./apachectl -f ./conf/httpd.conf -k stop

Stopping services on the Integration Bus node computer
You must stop the IBM Integration Bus services on the IBM Predictive Maintenance
and Quality Integration Bus node computer.

Procedure
1. Log in to the Integration Bus node computer as root.
2. Change to the mqm user. For example, enter the following command:

su -mqm

3. Go to the IBM Integration Bus bin directory. For example, go to
/opt/IBM/mqsi/9.0.0.2/bin.

4. Enter the following command:
./mqsistop pmqbroker -i

5. Enter the following command to verify that the services are stopped:
./mqsilist pmqbroker –e pmqgroup

Stopping services on the Analytics node computer
You must stop the IBM SPSS services on the IBM Predictive Maintenance and
Quality Predictive Analytics node computer.

Procedure
1. Log in to the Analytics node computer as root.
2. Go to the WebSphere Application Server SPSSProfile/bin directory. For

example, go to /opt/IBM/WebSphere/AppServer/profiles/SPSSProfile/bin.
3. Enter the following command:

./stopServer.sh server1

4. Go to the IBM SPSS Modeler Server directory. For example, go to
/usr/IBM/SPSS/ModelerServer/16.0.

5. Enter the following command:
./modelersrv.sh stop

6. To verify whether any services are still running enter the following command:
ps -ef | grep statisticsd

7. To stop any services that are still running enter the following command:
kill -9 'cat statisticsd.pid'

Stopping services on the data node computer
You must stop the IBM DB2 instance on the IBM Predictive Maintenance and
Quality data node computer.

Procedure
1. Log in to the data node computer as root.
2. In a terminal window, type the following command to change the DB2 instance

owner:
su - db2inst1
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3. Enter the following command to stop the DB2 administration server:
db2stop

Start solution services
Start the IBM Predictive Maintenance and Quality node services in the following
order:
1. data node
2. Predictive Analytics node
3. Integration Bus node
4. Business Intelligence (BI) node
5. Master Data Management (MDM) node

Starting services on the data node computer
You must start the IBM DB2 instance on the IBM Predictive Maintenance and
Quality data node computer.

Procedure
1. Log in to the data node computer as root.
2. In a terminal window, type the following command to change the DB2 instance

owner:
su - db2inst1

3. Enter the following command to stop the DB2 administration server:
db2start

Starting services on the Analytics node computer
You must start the IBM SPSS services on the IBM Predictive Maintenance and
Quality Predictive Analytics node computer.

Procedure
1. Log in to the Analytics node computer as root.
2. Go to the WebSphere Application Server SPSSProfile/bin directory. For

example, go to /opt/IBM/WebSphere/AppServer/profiles/SPSSProfile/bin.
3. Enter the following command:

./startServer.sh server1

4. Go to the IBM SPSS Modeler Server directory. For example, go to
/usr/IBM/SPSS/ModelerServer/16.0.

5. Enter the following command:
./modelersrv.sh start

Starting services on the Integration Bus node computer
You must start the IBM Integration Bus services on the IBM Predictive
Maintenance and Quality Integration Bus node computer.

Procedure
1. Log in to the Integration Bus node computer as root.
2. Change to the mqm user. For example, enter the following command:

su -mqm
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3. Go to the IBM Integration Bus bin directory. For example, go to
/opt/IBM/mqsi/9.0.0.2/bin.

4. Enter the following command:
./mqsistart pmqbroker

5. Enter the following command to verify that the services are started:
./mqsilist pmqbroker –e pmqgroup

6. Enter the following commands:
START LISTENER

END

Starting services on the BI node computer
You must start the IBM Cognos Business Intelligence services and IBM HTTP
Server on the IBM Predictive Maintenance and Quality Business Intelligence (BI)
node computer.

You start the IBM Cognos BI services by starting the WebSphere Application Server
profile where IBM Cognos BI is running.

Procedure
1. Log in to the BI node computer as root.
2. Go to the WebSphere Application Server profile directory when IBM Cognos BI

is running. For example, go to /opt/IBM/WebSphere/AppServer/profiles/
COGNOSProfile/bin.

3. Enter the following command:
./startServer.sh server1

4. Go to the IBM HTTP Server bin directory. For example, go to
/opt/IBM/HTTPServer/bin.

5. Enter the following command:
./apachectl -f ./conf/httpd.conf -k start

Starting services on the MDM node computer
Start the services on the Master Data Management (MDM) node after you start
services on other nodes.

Procedure
1. Log in to the MDM node computer as root.
2. Go to the MDM installation location. For example, go to /opt/IBM/MDM.
3. Go to the /bin/go directory.
4. Enter the following command:

./start_local.sh

5. Go to the WebSphere Application Server profile directory when MDM is
running. For example, go to /opt/IBM/WebSphere/AppServer/profiles/
MDMProfile/bin.

6. Enter the following command:
./startServer.sh server1
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Chapter 8. Switch software tags for your installation

If you change your usage of IBM Predictive Maintenance and Quality, such as to a
non-production environment from a production environment, you must switch the
software tags for your installation.

Starting the ILMT Utility to change software tags
Use the server artifacts Launchpad to start the IBM Licence Metric Tool (ILMT)
Utility to change IBM Predictive Maintenance and Quality software tags.

Before you begin

Ensure that you are logged in as root or a user with sudo permissions.

You must have a Firefox web browser that is installed and set as your default web
browser on the computer from where you run the IBM Predictive Maintenance and
Quality installation. Firefox must be version 17 as a minimum and version 20 at
the latest.

Procedure
1. Go to the directory where you downloaded the artifacts installation files.
2. If you are installing as a user with sudo permissions, enter the following

command to ensure that the Launchpad and Deployment Wizard open
correctly:
export DISPLAY=ipaddress:vncdisplay

where ipaddress is the IP address of the computer where you are running the
installation, and vncdisplay is the VNC display ID for the user who is running
the installation. For example, enter export DISPLAY=127.0.0.1:2

3. If you are installing as a user with sudo permissions, enter the following
command:
xhost +

4. Enter the following command:
./launchpad.sh

Important: Do not enter sudo in front of the command.
5. Review the information in the Launchpad panels.
6. Click Switch Software Tags.
7. Do one of the following steps:

v If you are installing as a user with sudo permissions, select Start the ILMT
Deployment Wizard as a Sudo User.
– In the Computer Name box, enter the name or IP address of the computer

on which you are running the Deployment Wizard.
– In the VNC Display ID box, enter the display for the user. For example,

enter 1 or 2.
v If you are installing as root, select Start the ILMT Deployment Wizard as

the Root User.
8. Click Start the ILMT Deployment Wizard.
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Switching software tags
Switch your IBM Predictive Maintenance and Quality software tags if your usage
changes. For example, if you installed the solution initially as a non-production
environment but want to move it to a production environment, you must switch
the software tags.

Procedure
1. On the Select Tasks page of the Deployment Wizard, select the option to

switch your tags:
v Select Switch from Production to Non-Production if you initially installed

Predictive Maintenance and Quality to a production environment.
v Select Switch from Non-Production to Production if you initially installed

Predictive Maintenance and Quality to a non-production environment.
2. Click Next.
3. Specify the target computers where a Predictive Maintenance and Quality node

is deployed.
For more information, see “Specifying the target computers on which to install
the artifacts” on page 53.

4. On the Configuration Parameters page, enter the location to where you want
to deploy the updated software tags, and click Next.

5. Click Deploy all.

Updating your software tags on client computers
After you use the ILMT utility to change your IBM Predictive Maintenance and
Quality software tags, you must copy the updated file to each client computer. You
must replace the existing file on the client computer with the updated software tag
file.

Procedure
1. Copy the iso-swid directory and contents from a directory where you updated

the software tag file to each computer on which you installed a Predictive
Maintenance and Quality client component.
For example, copy the directory and contents so that you replace the
/opt/IBM/PMQ/iso-swid directory. The iso-swid directory should contain one
swidtag file.

2. Delete the existing swidtag file.
You should have only one swidtag file in the directory.
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Chapter 9. Uninstallation of the server components

Follow the uninstall instructions for each of the IBM Predictive Maintenance and
Quality components to uninstall the product.

Uninstalling components from the Predictive Analytics node computer
Follow the uninstall instructions for each component on the IBM Predictive
Maintenance and Quality Analytics node computer.

Procedure
1. To uninstall the IBM DB2 client, see the IBM DB2 documentation

(www.ibm.com/support/knowledgecenter/SSEPGG_10.5.0/
com.ibm.db2.luw.qb.server.doc/doc/c0059726.html?lang=en).

2. To uninstall IBM SPSS Collaboration and Deployment Services, see the IBM
SPSS documentation (www.ibm.com/support/knowledgecenter/SS69YH_6.0.0).
a. Go to the /opt/IBM/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

3. To uninstall WebSphere Application Server, see the WebSphere documentation
(www.ibm.com/support/knowledgecenter/SSEQTP_8.5.5).
a. Go to the /opt/IBM/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

Note: If WebSphere Application Server processes are running and prevent you
from uninstalling the product, you must stop the server process. Go to the
/opt/IBM/WebSphere/AppServer/profiles/profile_name/bin directory, and type
./stopServer.sh server1.

4. To uninstall IBM Installation Manager, see the IBM Installation Manager
information center (pic.dhe.ibm.com/infocenter/install/v1r6).
a. Go to the /var/ibm/InstallationManager/uninstall directory, and run

uninstall.
b. Follow the steps to uninstall IBM Installation Manager.

5. Remove the licence and iso-swid directories. For example, if you used the
default path, /opt/IBM/PMQ, remove the /opt/IBM/PMQ/license and
/opt/IBM/PMQ/iso-swid directories.

Uninstalling components from the BI node computer
Follow the uninstall instructions for each component on the IBM Predictive
Maintenance and Quality Business Intelligence (BI) node computer.

Procedure
1. To uninstall the IBM DB2 client, see the IBM DB2 documentation

(www.ibm.com/support/knowledgecenter/SSEPGG_10.5.0/
com.ibm.db2.luw.qb.server.doc/doc/c0059726.html?lang=en).

2. To uninstall IBM Cognos Business Intelligence, see the IBM Cognos BI
documentation (www.ibm.com/support/knowledgecenter/SSEP7J_10.2.2/
com.ibm.swg.ba.cognos.inst_cr_winux.10.2.2.doc/
c_uninstallingcognos8single.html%23UninstallingCognos8Single).
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a. Go to the /opt/IBM/cognos/c10_64/uninstall directory.
b. Type ./uninst -u, and press Enter.
c. From the Start menu, click All Programs > IBM Cognos 10 - 64 > Uninstall

IBM Cognos > Uninstall IBM Cognos.
d. Follow the steps to uninstall the product.

3. To uninstall IBM HTTP Server, see the IBM HTTP Server for WebSphere
Application Server documentation (www.ibm.com/support/knowledgecenter/
SSEQTJ_8.5.5).
a. Go to the /opt/IBM/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

4. To uninstall WebSphere Application Server, see the WebSphere documentation
(www.ibm.com/support/knowledgecenter/SSEQTP_8.5.5).
a. Go to the /opt/IBM/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

Note: If WebSphere Application Server processes are running and prevent you
from uninstalling the product, you must stop the server process. Go to the
/opt/IBM/WebSphere/AppServer/profiles/profile_name/bin directory, and type
./stopServer.sh server1.

5. To uninstall IBM Installation Manager, see the IBM Installation Manager
information center (pic.dhe.ibm.com/infocenter/install/v1r6).
a. Go to the /var/ibm/InstallationManager/uninstall directory, and run

uninstall.
b. Follow the steps to uninstall IBM Installation Manager.

6. Remove the licence and iso-swid directories. For example, if you used the
default path, /opt/IBM/PMQ, remove the /opt/IBM/PMQ/license and
/opt/IBM/PMQ/iso-swid directories.

Uninstalling components from the Integration Bus node computer
Follow the uninstall instructions for each component on the IBM Predictive
Maintenance and Quality Integration Bus node computer.

Procedure
1. To uninstall the IBM DB2 client, see the IBM DB2 documentation

(www.ibm.com/support/knowledgecenter/SSEPGG_10.5.0/
com.ibm.db2.luw.qb.server.doc/doc/c0059726.html?lang=en).

2. To uninstall IBM Integration Bus, see the IBM Integration Bus documentation
(www.ibm.com/support/knowledgecenter/SSMKHH_9.0.0).

3. To uninstall WebSphere MQ, see the WebSphere MQ documentation
(www.ibm.com/support/knowledgecenter/SSFKSJ_7.5.0).

4. Remove the licence and iso-swid directories. For example, if you used the
default path, /opt/IBM/PMQ, remove the /opt/IBM/PMQ/license and
/opt/IBM/PMQ/iso-swid directories.

Uninstalling components from the MDM node computer
Follow the uninstall instructions for each component on the Master Data
Management (MDM) node computer.
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Procedure
1. To uninstall the IBM DB2 client, see the IBM DB2 documentation

(www.ibm.com/support/knowledgecenter/SSEPGG_10.5.0/
com.ibm.db2.luw.qb.server.doc/doc/c0059726.html?lang=en).

2. To uninstall InfoSphere Master Data Management Server, see the IBM MDM
documentation (www.ibm.com/support/knowledgecenter/SSWSR9_11.4.0/
com.ibm.swg.im.mdmhs.release.install.doc/Topics/uninstalling_mdm.html).
a. Go to the /opt/IBM/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

3. To uninstall WebSphere Application Server, see the WebSphere documentation
(www.ibm.com/support/knowledgecenter/SSEQTP_8.5.5).
a. Go to the /opt/IBM/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

Note: If WebSphere Application Server processes are running and prevent you
from uninstalling the product, you must stop the server process. Go to the
/opt/IBM/WebSphere/AppServer/profiles/profile_name/bin directory, and type
./stopServer.sh server1.

4. To uninstall IBM Installation Manager, see the IBM Installation Manager
information center (pic.dhe.ibm.com/infocenter/install/v1r6).
a. Go to the /var/ibm/InstallationManager/uninstall directory, and run

uninstall.
b. Follow the steps to uninstall IBM Installation Manager.

5. Remove the licence and iso-swid directories. For example, if you used the
default path, /opt/IBM/PMQ, remove the /opt/IBM/PMQ/license and
/opt/IBM/PMQ/iso-swid directories.

Uninstalling components from the data node computer
Follow the uninstall instructions for each component on the IBM Predictive
Maintenance and Quality data node computer.

Procedure
1. To uninstall IBM DB2, see the IBM DB2 documentation (www.ibm.com/

support/knowledgecenter/SSEPGG_10.5.0/com.ibm.db2.luw.qb.server.doc/
doc/c0059726.html?lang=en).

2. Remove the licence and iso-swid directories. For example, if you used the
default path, /opt/IBM/PMQ, remove the /opt/IBM/PMQ/license and
/opt/IBM/PMQ/iso-swid directories.
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Appendix A. Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products.

For information about the commitment that IBM has to accessibility, see the IBM
Accessibility Center (www.ibm.com/able).

IBM Cognos HTML documentation has accessibility features. PDF documents are
supplemental and, as such, include no added accessibility features.

Report output

In IBM Cognos Administration, you can enable system-wide settings to create
accessible report output. For more information, see the IBM Cognos Business
Intelligence Administration and Security Guide. In IBM Cognos Report Studio, you can
enable settings to create accessible output for individual reports. For more
information, see the IBM Cognos Report Studio User Guide. You can access the
previously mentioned documents at IBM Knowledge Center (http://
www.ibm.com/support/knowledgecenter).
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Appendix B. Troubleshooting

This section contains troubleshooting information for the IBM Predictive
Maintenance and Quality installation.

Launchpad does not start
If the IBM Predictive Maintenance and Quality Launchpad does not launch, ensure
that you have completed all of the prerequisite tasks and installed all of the
required rpm packages.

Browser support for the Launchpad
You must also have a Firefox web browser that is installed and set as your default
web browser on the computer from where you run the IBM Predictive
Maintenance and Quality installation. Firefox must be version 17 as a minimum
and version 20 at the latest.

If you have another browser that is set as your default and want to keep your
existing default browser, you can temporarily use a supported browser for the
installation.

Procedure
1. On the computer from where you run the installation, download a supported

web browser. For example, download Firefox version 20.
2. Decompress the downloaded file if necessary.
3. In a terminal window, type the following command:

export BROWSER=/path_to_supported_browser

4. Then, start the Launchpad by typing the following command:
./launchpad.sh

The Launchpad should appear in the supported browser.

Installer fails and shows Java Result:1 message in console
From the Install and Configure Server Computers page on the Launchpad, you
receive a [java] Java Result:1 message in the terminal window.

This error occurs if you are missing the 32 bit version of the X11 runtime libraries.

To resolve this error, you must install the libraries on the computer on which you
are running the IBM Predictive Maintenance and Quality installation.

If you have yum repositories configured for your computer, use the following
command to install the library:

yum -y install xulrunner.i686

You can verify that the library is installed by using the following command:

rpm -ql xulrunner.i686 | grep so
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If the path indicates /usr/lib/xulrunner, then the 32 bit libraries are installed. The
path for the 64 bit libraries would contain /usr/lib64.

After you install the library, do the following to restart the installation:
1. Close the installer.
2. Clean the /tmp directory on all server node computers.
3. Clean the /opt/IBM/SolutionFile directory on the computer on which you are

running the installation.
4. Try the installation again.

The following 32 bit X11 libraries must also be installed. Use the rpm -ql
library_name | grep so command to verify that the 32 bit versions are installed.
v libdmx

v libXaw

v libXft

v libXpm

v libXv

v libfontenc

v libXcursor

v libXi

v libXrandr

v libXxf86dga

v libFS

v libXdmcp

v libXinerama

v libXrender

v libXxf86misc

v libICE

v libXext

v libxkbfile

v libXres

v libXxf86vm

v libSM

v libXfixes

v libXmu

v libXt

v libXcomposite

v libX11

v libXfontt

v libXmuu

v libXTrap

v libXdamage

v libXau

v libXfontcache

v libXp

v libXtst
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v libXevie

v libXss

v libXvMC

Test Connections validation errors
If you click the Test Connections button in the IBM Predictive Maintenance and
Quality installer and you receive an error, use the following tips to verify
communication between the Deployment Wizard and the target computer.
v Ensure that you entered a valid host name or IP address.
v Ensure that you can ping the target computer from the computer where you are

running the installation.
v Ensure that your firewall is disabled or that the ports required for the

Deployment Wizard are open on all computers.
v Ensure that all of your node computers have valid entries in the /etc/hosts file

on each node. You must include each node computer in the /etc/hosts files.
For example, ensure that your hosts file contains values such as the following
values:
127.0.0.1 localhost.localdomain localhost
##.##.##.## analytics_node_name.domain.com analytics_node_name
##.##.##.## bi_node_name.domain.com bi_node_name
##.##.##.## data_node_name.domain.com data_node_name
##.##.##.## integrationbus_node_name.domain.com integrationbus_node_name
##.##.##.## mdm_node_name.domain.com mdm_node_name

v Ensure that you have correct entries in the /etc/resolv.conf file.

Timeout errors during installation
If you encounter timeout errors during the installation, you can continue the
installation by running each deployment task individually.

Depending on your computer's network speed, you might encounter timeouts as
processes can take some time to complete. If timeout errors do occur, in the
Deployment Wizard, click Back to return to the list of deployment tasks, and run
each of the remaining tasks individually.

Important: Do not rerun the task where the timeout occurred. The task is
complete, and running it again causes other errors.

WebSphere Application Server fails to deploy on BI node computer
If the WebSphere Application Server installation fails on the IBM Predictive
Maintenance and Quality Business Intelligence (BI) node computer and the
installer appears inactive for a long time, such as an hour, then you might have to
restart the installation.

Procedure
1. Verify that the BI node computer is running.
2. Cancel the installation.
3. Follow the procedures in Chapter 9, “Uninstallation of the server components,”

on page 83 to remove any installed components.
4. Restart the installation.
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Viewing log files
Log files for the IBM Predictive Maintenance and Quality installation can be
displayed in the Deployment Wizard.

If you want to view log files directly, the log files are saved to the
/tmp/SL_####/SolutionEnabler directory.

Procedure
1. To view log files in the Deployment Wizard, select the message, and click

Detailed messages or Master log.
2. If you clicked Detailed messages, select a message, and click View Details.

JAVA_HOME not set when starting IBM Cognos Configuration
After you install IBM Predictive Maintenance and Quality as a sudo user, you
receive a message that the JAVA_HOME environment variable is not set.

You can resolve this be setting the JAVA_HOME environment variable. You must use
the JRE that is provided with the WebSphere Application Server installation.

Procedure
1. On the Business Intelligence (BI) node computer, in terminal window, enter the

following command:
export JAVA_HOME=/WebSphere_Install_location/AppServer/java

For example, enter
export JAVA_HOME=/opt/IBM/WebSphere/AppServer/java

2. Go to the /opt/IBM/cognos/c10_64/bin64 directory.
3. Type the following command:

./cogconfig.sh

IBM Cognos Configuration starts.
4. If you want to save this setting for future session, add the command to the

user's .bash_profile file.

Temporary file locations
Temporary files are created during the IBM Predictive Maintenance and Quality
installation. You can find the location for the temporary files from the Deployment
Wizard.

The temporary files include jar files that are used during the installation, which
you might want to delete after you complete the installation.

Procedure

In the Deployment Wizard, click Edit > Preferences.
The path to the location for the temporary files is shown in the Path box.

Modeler Server type not displaying in resource definitions
In IBM Predictive Maintenance and Quality, if the Modeler Server type does not
display in resource definitions in IBM SPSS Collaboration and Deployment Services
Deployment Manager, try closing Deployment Manager and opening it again.
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Unable to import the company archive in MDM
If you cannot import the IBM Predictive Maintenance and Quality company
archive in the Master Data Management (MDM) console, you can manually import
the archive.

Procedure
1. Log in to the MDM node computer as root.
2. Copy the IBMPMQ.zip file from /opt/IBM/PMQ/MDM_version directory to the

/opt/IBM/PMQ directory.
3. Enter the following command:

$TOP/bin/importCompanyFromZip.sh --company_code=IBMPMQ
--zipfile_path=/opt/IBM/PMQ/IBMPMQ.zip

Error installing IBM Cognos BI
The IBM Cognos Business Intelligence installer requires a specific library file in
order to run.

If you encounter this error installing IBM Predictive Maintenance and Quality, see
the IBM support page (http://www.ibm.com/support/
docview.wss?uid=swg21612290) for information on how to correct the error.

Restarting the queue manager and broker
After a IBM Predictive Maintenance and Quality Integration Bus node server
restart, you might need to restart the queue manager and broker.

Procedure
1. Log on to the Integration Bus node computer.
2. In a terminal window, go to the installation_location/mqsi/9.0.0.2/bin

directory. For example, if you installed to the default location, go to the
/opt/IBM/mqsi/9.0.0.2/bin directory.

3. Change to the mqm user. For example, su mqm.
4. Enter the following command to load the profile that is needed for the mqm

user, and press Enter:
. ~/.bash_profile

5. Enter the following command to start the queue manager:
strmqm queue_manager_name

For example, to start the default broker named pmqmanager, enter:
strmqm pmqmanager

6. Enter the following command to start the broker:
mqsistart broker_name

For example, to start the default broker named pmqbroker, enter:
mqsistart pmqbroker

Error loading shared libraries: libImbCmdLib.so
An error message that states libImbCmdLib.so: cannot open shared object file:
No such file or directory can indicate that environment variables are not correct.
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Verify the environment variables, specifically ones that are related to the IBM
Integration Bus broker.

Also, ensure that the link inside /opt/IBM/mqsi/9.0.0.2/lib/headless is removed.

Errors deploying Cognos BI server artifacts
While you are deploying the IBM Cognos BI server artifacts, you receive error
messages in the master log. This issue can be caused by entering the incorrect
value for the IBM Cognos BI dispatcher URI in the Deployment Wizard.

The following error message appears in the master log:
[exec] java.net.MalformedURLException: For input string: "<port>"
[exec] at java.net.URL.<init>(URL.java:613)
[exec] at java.net.URL.<init>(URL.java:476)
[exec] at java.net.URL.<init>(URL.java:425)
[exec] at Import_Partial_Whole.connectToReportServer

(Import_Partial_Whole.java:353)
[exec] at Import_Partial_Whole.main(Import_Partial_Whole.java:137)
[exec] Exception in thread "main" java.lang.NullPointerException
[exec] at Import_Partial_Whole.addArchive(Import_Partial_Whole.java:396)
[exec] at Import_Partial_Whole.deployContent(Import_Partial_Whole.java:238)
[exec] at Import_Partial_Whole.main(Import_Partial_Whole.java:149)

To resolve this problem, you must enter the host name and the port number for
the IBM Cognos Dispatcher URI in the Deployment Wizard. For example,
http://hostname:port/p2pd/servlet/dispatch.

You must enter the correct hostname value and port number. The default port
number is 9080.

Improving performance for IBM Cognos reports
To improve the performance of IBM Cognos Business Intelligence reports, you can
run a cron job that is created by the installation.

The cron job is run every hour by default. However, you can modify that interval.

The cron job is automatically created on the data node computer, in the
/home/db2inst1 directory and is named mycron.

If you want to change the interval for running the job, you must update the cron
job by using the following command:

Vi crontab -e

IBM Integration Bus related nodes are missing after migration
After you migrate IBM Predictive Maintenance and Quality, you open MQ
Explorer and IBM Integration Bus related nodes are missing.

You can resolve this issue by forcing the program to reinitialize the MBExplorer
plugin.
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Procedure
1. On the Integration Bus node computer, go to the MQExplorer_Installation/

eclipse/links directory. For example, go to the /opt/mqm/mqexplorer/
eclipse/links directory.

2. Make a copy of com.ibm.wmadmin.broker.explorer.link as a backup. You will
copy this file back to this directory later.

3. Delete com.ibm.wmadmin.broker.explorer.link.
4. Go to the /opt/mqm/bin directory.
5. Enter the following command to start MQ Explorer:

./strmqcfg -c

6. After MQ Explorer is fully loaded, close the program.
7. Go back to the /opt/mqm/mqexplorer/eclipse/links directory.
8. Replace com.ibm.wmadmin.broker.explorer.link from your backup.
9. Go back to the /opt/mqm/bin directory.

10. Restart MQ Explorer using the following command:
./strmqcfg -c

Master Data Management web portal available only in Internet Explorer
9 browsers

You must use Microsoft Internet Explorer version 9 to access the IBM InfoSphere
Master Data Management web portal.

The URL is http://mdm_node_name:7507/utils/enterLogin.jsp

Error configuring NFS mount settings
You are configuring network file system (NFS) mounts on the Integration Bus node
and the Predictive Analytics node computers to allow file transfers between these
nodes. When you restart the Linux services, an error occurs.

You enter the service portmap restart command and receive the following error:
portmap: unrecognized service

To resolve the problem, restart the operating system and then reissue the
command.
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Appendix C. Samples

Sample data is provided so that you can see the IBM Predictive Maintenance and
Quality solution work end-to-end.

Loading the sample data
Sample data is installed as part of the IBM Predictive Maintenance and Quality
server artifact installation. You can load the sample data to see an example of the
Predictive Maintenance and Quality solution from end-to-end.

The sample data is provided in different languages. If you want to change the
language of the data, you must ensure that the Predictive Maintenance and Quality
data store content is deleted, and that you restart your brokers.

Tip: You can verify that the data was loaded by using commands to check the
Predictive Maintenance and Quality queues. You can check the queues by running
the following commands:
runmqsc pmqmanager
Display q(PMQ.*) WHERE(CURDEPTH NE 0)

Procedure
1. Log in to the Integration Bus node computer as the mqm user.

Important: The user must be the mqm user or a member of the mqm group. If you
copy the files as another user, they might not be processed by the Integration
Bus node components.

2. Load the master data.
a. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/language/

Set1-MasterData directory.
b. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/

masterdatain directory one file at a time.
WebSphere Message Broker automatically loads the files from that directory.
The files are automatically removed after they are loaded.

Important: The files must be copied one at a time.
c. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/language/

Set2-MasterData directory.
d. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/

masterdatain directory one file at a time.
e. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/language/

Set3-MasterData directory.
f. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/

masterdatain directory one file at a time.
g. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/language/

Set4-MasterData directory.
h. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/

masterdatain directory one file at a time.
3. Load the event data.
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a. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/language/
Set2-EventData directory.

b. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/
eventdatain directory one file at a time.

c. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/language/
Set3-EventData directory.

d. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/
eventdatain directory one file at a time.

4. Set the appropriate time triggers in the
PMQ_orchestration_definition_batch.xml file.
a. Go to the /var/PMQ/MQSIFileInput/properties directory.
b. Open PMQ_orchestration_definition_batch.xml in a text editor.
c. Locate each of the following sections, and set the <scheduled_time> value to

an appropriate time.

Table 27. Predictive Maintenance and Quality feature and identifier value

Feature <Identifer> value

TopNFailure TopN

Maintenance Maintenance

Sensor Analytics Training HSTrigger

Feature Based Analytics Training FHSTrigger

Integrated Analytics Training IHSTrigger

d. Use the following command to stop AutoTrigger.msgflow in the
PMQBatchIntegration application:
mqsistopmsgflow pmqbroker -e pmqgroup1 -k PMQBatchIntegration -m
AutoTrigger

e. Use the following command to restart AutoTrigger.msgflow in the
PMQBatchIntegration application:
mqsistartmsgflow pmqbroker -e pmqgroup1 -k PMQBatchIntegration -m
AutoTrigger

5. Load the event data for scoring.
a. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/language/

Set4-EventData directory.
b. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/

eventdatain directory one file at a time.
6. Load the batch data.

a. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/language/
Set5-BatchData directory.

b. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/
batchdatain directory one file at a time.

Loading the ENU sample data
ENU Sample data is installed as part of the IBM Predictive Maintenance and
Quality server artifact installation. The data covers examples for substations,
distribution transformers, and poles and cables.
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The sample data is provided in different languages. If you want to change the
language of the data, you must ensure that the Predictive Maintenance and Quality
data store content is deleted, and that you restart your brokers.

Tip: You can verify that the data was loaded by using commands to check the
Predictive Maintenance and Quality queues. You can check the queues by running
the following commands:
runmqsc pmqmanager
Display q(PMQ.*) WHERE(CURDEPTH NE 0)

Procedure
1. Log in to the Integration Bus node computer as the mqm user.

Important: The user must be the mqm user or a member of the mqm group. If you
copy the files as another user, they might not be processed by the Integration
Bus node components.

2. Load the data.
a. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/language/

Set6-EventData_ENU directory.
b. Copy the following files, in sequence, to the /var/PMQ/MQSIFileInput/

eventdatain directory one file at a time.
1) event_observation_parameter*.csv—Loads parameter data.
2) event_observation_*_training.csv—Loads training data.
3) event_observation_pole_inspection.csv—Loads pole data.

3. Set the appropriate time triggers in the
PMQ_orchestration_definition_batch.xml file.
a. Go to the /var/PMQ/MQSIFileInput/properties directory.
b. Open PMQ_orchestration_definition_batch.xml in a text editor.
c. Locate each of the following sections, and set the <scheduled_time> value to

an appropriate time.

Table 28. Predictive Maintenance and Quality feature and identifier value

Feature <Identifer> value

TopNFailure TopN

Maintenance Maintenance

Sensor Analytics Training HSTrigger

Feature Based Analytics Training FHSTrigger

d. Use the following command to stop AutoTrigger.msgflow in the
PMQBatchIntegration application:
mqsistopmsgflow pmqbroker -e pmqgroup1 -k PMQBatchIntegration -m
AutoTrigger

e. Use the following command to restart AutoTrigger.msgflow in the
PMQBatchIntegration application:
mqsistartmsgflow pmqbroker -e pmqgroup1 -k PMQBatchIntegration -m
AutoTrigger

4. Load the event data for scoring.
a. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/language/

Set6-EventData_ENU directory.
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b. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/
eventdatain directory one file at a time. For example, copy
event_observation_feature_*_scoring.csv.

5. Reset the time triggers in the PMQ_orchestration_definition_batch.xml file.
a. Go to the /var/PMQ/MQSIFileInput directory.
b. Open PMQ_orchestration_definition_batch.xml in a text editor.
c. Locate each of the following sections, and set the <sequence_time> value to

an appropriate time.

Table 29. Predictive Maintenance and Quality feature and identifier value

Feature <Identifer> value

Distribution transformer Current aging DTCA

Distribution transformer Projected aging DTPA

Note: If you are resetting the scheduler of any batch feature that is set to
run for a duration_in_days that is greater than 1 day, then you must restart
AutoTrigger.msgflow in the PMQBatchIntegration application to see the
changes immediately.

d. Use the following command to stop AutoTrigger.msgflow in the
PMQBatchIntegration application:
mqsistopmsgflow pmqbroker -e pmqgroup1 -k PMQBatchIntegration -m
AutoTrigger

e. Use the following command to restart AutoTrigger.msgflow in the
PMQBatchIntegration application:
mqsistartmsgflow pmqbroker -e pmqgroup1 -k PMQBatchIntegration -m
AutoTrigger

Modify master data references for blank entries
Some master data, which is not mandatory from a business aspect, are required
due to foreign key relationships within the IBM Predictive Maintenance and
Quality data model. To overcome this, Predictive Maintenance and Quality uses
the concept of an NA (not applicable) master data row entry. As a result, whenever
such master data references have a blank value, Predictive Maintenance and
Quality uses the -NA- business key code row reference. You must configure the
master data tables that require the -NA- entries.

The following table provides the table names that require the -NA- entries and
samples master data files that you can use to reference which tables require the
entries.

Table 30. Tables that require -NA- entries, and sample files you can reference

Table name Sample master data file

MASTER_GROUP_DIM group_dim_upsert.csv

MASTER_LOCATION location_upsert.csv

MASTER_MATERIAL_TYPE material_type_upsert.csv

MASTER_PROCESS process_upsert.csv

MASTER_PRODUCT product_upsert.csv

MASTER_SOURCE_SYSTEM source_system_upsert.csv

MASTER_SUPPLIER supplier_upsert.csv
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Table 30. Tables that require -NA- entries, and sample files you can reference (continued)

Table name Sample master data file

MASTER_MATERIAL material_upsert.csv

MASTER_PRODUCTION_BATCH production_batch_upsert.csv

MASTER_RESOURCE resource_upsert.csv

Verifying that the sample data was loaded correctly
You can verify that the IBM Predictive Maintenance and Quality sample data was
loaded by checking the error and log directories and viewing reports.

Procedure
1. Check the error directory on the Integration Bus node computer to ensure that

there were no errors when the data was loaded.
2. Check the status of the IBM SPSS jobs by reviewing the following files in the

Integration Bus node log directory of the ESB node:
v TopNFailureLog.txt

v MaintenanceLog.txt

v Training_HS_in.csv

v Training_FBA_in.csv

v Training_IHS_in.csv

3. The following reports should be populated with the sample data:

Table 31. Sample data and reports

Data Report or dashboard

Master data Audit Reports

Resource Site Overview dashboard

Equipment dashboard

Advance KPI Trend reports

Process and material Product Quality dashboard and

Material Usage by Production batch report

SPC SPC - Histogram

SPC - X bar R/S chart

QEWS QEWS Inspection

QEWSL Warranty

Maintenance, sensor health score, and
integrated health score

Maintenance Overview dashboard

Maintenance Health and Failure Detail
report

Maintenance Advance Sorting report

TopNFailure Top N Failure Analysis report

4. If you are using the ENU sample data, check the status of the SPSS jobs by
reviewing the following log files:
v dt_currentageing_in.csv
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v dt_projectedageing_in.csv

Removing sample data
Before you load live production data in IBM Predictive Maintenance and Quality,
all sample data must be removed.

This procedure deletes all the contents of the event and master data tables. Its
scope is not limited to the supplied sample data and so any additional content that
is loaded is also deleted.

Before you begin

If test events were loaded from the sample master data, the test events must also
be removed. For more information, see the IBM Predictive Maintenance and Quality
Solution Guide.

Procedure
1. Type the following command to connect to the IBMPMQ datastore:

db2 connect to IBMPMQ user user_name using password

2. Enter the following SQL statements to remove the Predictive Maintenance and
Quality data:
DELETE FROM PMQSCH.PARAMETRIC_KPI;
DELETE FROM PMQSCH.PARAMETRIC_PROFILE;
delete PMQSCH.lifetime_kpi;
delete PMQSCH.lifetime_profile;
delete PMQSCH.product_profile;
delete PMQSCH.product_kpi;
delete PMQSCH.resource_profile;
delete PMQSCH.resource_kpi;
delete PMQSCH.material_profile;
delete PMQSCH.process_kpi;
delete PMQSCH.process_profile;
delete PMQSCH.PROFILE_parameter;
DELETE FROM PMQSCH.EVENT_PROFILE;
delete PMQSCH.event_observation;
delete PMQSCH.event;
DELETE PMQSCH.MASTER_RESOURCE_CONNECTION;
DELETE PMQSCH.MASTER_PROFILE_MAPPING;
delete PMQSCH.master_resource_production_batch;
delete PMQSCH.master_production_batch;
delete PMQSCH.service;
delete PMQSCH.master_PRODUCT_hierarchy;
Delete PMQSCH.master_product;
delete PMQSCH.master_resource_hierarchy;
delete PMQSCH.master_resource;
delete PMQSCH.master_profile_variable;
delete PMQSCH.master_material;
delete PMQSCH.master_material_type;
delete PMQSCH.master_profile_calculation;
delete PMQSCH.master_resource_type;
delete PMQSCH.master_measurement_type;
delete PMQSCH.master_value_type;
delete PMQSCH.master_supplier;
delete PMQSCH.master_source_system;
delete PMQSCH.master_process_hierarchy;
delete PMQSCH.master_process;
delete PMQSCH.master_location;
delete PMQSCH.master_group_dim;
delete PMQSCH.master_event_type;
delete PMQSCH.master_event_code;
delete PMQSCH.master_observation_lookup;
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delete PMQSCH.maintenance_trends;
delete PMQSCH.maintenance_daily;
delete PMQSCH.maintenance_adm_recommendations;
delete PMQSCH.topn_predictors;
delete PMQSCH.key_lookup;
delete PMQSCH.language;
delete PMQSCH.tenant;

3. Enter the following SQL statements to alter tables:
ALTER TABLE “PMQSCH ”.“EVENT” ALTER COLUMN “EVENT_ID” RESTART WITH 1;
ALTER TABLE “PMQSCH ”.“LANGUAGE” ALTER COLUMN “LANGUAGE_ID” RESTART WITH 1;
ALTER TABLE “PMQSCH ”.“TENANT” ALTER COLUMN “TENANT_ID” RESTART WITH 1;
ALTER TABLE “PMQSCH ”.“KEY_LOOKUP” ALTER COLUMN “KEY_LOOKUP_ID” RESTART WITH 1;
ALTER TABLE “PMQSCH ”.“MASTER_PROFILE_CALCULATION” ALTER COLUMN
“MASTER_PROFILE_CALCULATION_ID” RESTART WITH 1;

4. Type the following command to disconnect from the database:
db2 connect reset

5. Restart the pmqgroup1 integration server (in previous versions, called an
execution group).
For more information, see the IBM Integration Bus documentation.
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Appendix D. Installation of the server components in silent
mode

You can install the IBM Predictive Maintenance and Quality server components in
silent mode.

Editing the properties files for a silent installation of the server
components

You must edit the properties files for the silent mode installation of the IBM
Predictive Maintenance and Quality server components.

Procedure
1. Go to the disk1/IBMPMQ_Server/disk1 directory where you decompressed the

installation files.
2. Edit the license properties file.

a. Open the IRU_install_properties file in a text editor.
b. Add the following line after licenseType=LICR:

licenseAccepted=9

c. Save and close the file.
3. Edit the installation properties file.

a. Go to the disk1/IBMPMQ_Server/disk1/taskFile directory where you
decompressed the installation files.

b. Open the properties file for the type of installation you want to run.
v For an express installation, that uses default values for each component,

edit Express_WithMDMNode_task.xml.
v For an express installation without IBM Master Data Management, edit

Express_WithoutMDMNode_task.xml.
v For a custom installation, where you choose values for all of the

components, edit Custom_WithMDMNode_task.xml.
v For a custom installation without IBM Master Data Management, edit

Custom_WithoutMDMNode_task.xml.
c. In the task.xml file, remove <!-- and --> surrounding the

<credentialsSet> section of the file to uncomment the section.
d. Enter the user credentials for each node computer in the userID and

password values in the <credentialsSet> section of the file.
e. Change all instances of AnalyticsNode.sample.com to the fully qualified

domain name of the Predictive Analytics node computer.
f. Change all instances of BINode.sample.com to the fully qualified domain

name of the Business Intelligence (BI) node computer.
g. Change all instances of DataNode.sample.com to the fully qualified domain

name of the data node computer.
h. Change all instances of ESBNode.sample.com to the fully qualified domain

name of the Integration Bus node computer.
i. Change all instances of MDMNode.sample.com to the fully qualified domain

name of the Master Data Management (MDM) node computer.
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j. For a custom installation, enter or confirm the remaining values in the
task.xml file.

k. Save and close the file.

Editing the properties files for a silent installation of the server
artifacts

You must edit the properties files for the silent mode installation of the IBM
Predictive Maintenance and Quality server artifacts.

Procedure
1. Go to the disk1/IBMPMQ_ServerArtifact/disk1 directory where you

decompressed the installation files.
2. Edit the license properties file.

a. Open the IRU_install_properties file in a text editor.
b. Add the following line after licenseType=LICR:

licenseAccepted=9

c. Save and close the file.
3. Edit the installation properties file.

a. Go to the disk1/IBMPMQ_ServerArtifact/disk1/task directory where you
decompressed the installation files.

b. In the task.xml file, remove <!-- and --> surrounding the
<credentialsSet> section of the file to uncomment the section.

c. Enter the user credentials for each node computer in the userID and
password values in the <credentialsSet> section of the file.

d. In each <deploy taskNumber=“#”> section, edit the values to match your
environment. For example, ensure you use the fully qualified domain name
ir IP address for each node computer, and that you ensure the passwords
and locations are correct.

e. If you are not installing IBM Master Data Management, comment out the
<deploy taskNumber=“5”> element. This element includes <application
id=“Master_Data_Management”>.

f. Save and close the file.

Editing the properties files for a silent installation of the client
components

You must edit the properties files for the silent mode installation of the IBM
Predictive Maintenance and Quality client components.

The client components silent installation must be run on a computer running a
Microsoft Windows operating system.

Procedure
1. Go to the disk1\IBMPMQ_ServerArtifact\disk1 directory where you

decompressed the installation files.
2. Edit the license properties file.

a. Open the IRU_install_properties file in a text editor.
b. Add the following line after licenseType=LICR:

licenseAccepted=9
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c. Save and close the file.
3. Edit the installation properties file.

a. Go to the disk1\IBMPMQ_ServerArtifact\disk1\task directory where you
decompressed the installation files.

b. In the task.xml file, remove <!-- and --> surrounding the
<credentialsSet> section of the file to uncomment the section.

c. Enter the user credentials for the computer in the hostname, userID and
password values in the <credentialsSet> section of the file.

d. In each <deploy taskNumber=“#”> section, edit the values for your
environment.

e. Comment out any client components you do not want to install.
f. Save and close the file.

Starting the silent installation
You start the IBM Predictive Maintenance and Quality silent installation by
running a command.

Procedure
1. Go to the disk1/IBMPMQ_Server/disk1 directory where you downloaded the

installation files.
2. Enter the following command to install the server components:

./LinuxSetup
-responseFile /path_to_install_files/disk1/IBMPMQ_Server/disk1/
IRU_install.properties
-taskFile /path_to_install_files/disk1/
IBMPMQ_Server/disk1/taskFile/xxxx_task.xml -silent

Where xxxx_task.xml is task file you modified.
Log messages for the installation are saved to /opt/SolutionFiles/logs/
IRU_progress.log. If the log file contains Progress=92, it means that all of
components were successfully deployed.

3. Enter the following command to install the server artifacts:
./LinuxSetup
-responseFile /path_to_install_files/disk1/IBMPMQ_ServerArtifact/disk1/
IRU_install.properties
-taskFile /path_to_install_files/disk1/IBMPMQ_ServerArtifact/disk1/
taskFile/xxxx_task.xml -silent

Where xxxx_task.xml is task file you modified.
Log messages for the installation are saved to /opt/SolutionFiles/logs/
IRU_progress.log. If the log file contains Progress=92, it means that all of
components were successfully deployed.

4. On a computer that is running a Microsoft Windows operating system, enter
the following command to install the client components:
WindowsSetup
-responseFile path_to_install_files\disk1\IBMPMQ_Client\disk1\
IRU_install.properties
-taskFile path_to_install_files\disk1\IBMPMQ_Client\disk1\
taskFile\xxxx_task.xml -silent

Where xxxx_task.xml is task file you modified.
Log messages for the installation are saved to C:\Program Files\Common
Files\SolutionFiles\logs\IRU_progress.log. If the log file contains
Progress=88, that means that all of components were successfully deployed.
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Appendix E. Supporting programs licensed with IBM
Predictive Maintenance and Quality

The following supporting programs are licensed with Predictive Maintenance and
Quality.

Supporting programs
v IBM Cognos Business Intelligence Analytics Administrator 10.2
v IBM Cognos Business Intelligence Software Development Kit 10.2
v IBM Cognos Business Intelligence Samples 10.2
v IBM Cognos Supplementary Languages Documentation 10.2
v IBM Analytical Decision Management 8.0
v IBM Analytical Decision Management Application 8.0
v IBM SPSS Modeler Premium 16.0
v IBM SPSS Modeler Server Premium 16.0
v IBM SPSS Modeler Solution Publisher 16.0
v IBM SPSS Modeler Premium Solution Publisher 16.0
v IBM SPSS Statistics Standard 22.0
v IBM SPSS Statistics Server Standard 22.0
v IBM SPSS Statistics - Essentials for Python 22.0
v IBM SPSS Collaboration and Deployment Services Adapter for Statistics 22.0
v IBM SPSS Collaboration and Deployment Services 6.0
v IBM SPSS Collaboration and Deployment Services Deployment Manager 6.0
v IBM SPSS Collaboration and Deployment Services - Real Time Scoring 6.0
v IBM SPSS Collaboration and Deployment Services Deployment Portal 6.0
v IBM SPSS Data Access Pack 7.1
v IBM SPSS Concurrent Licensing Tools 9.5
v IBM DB2 Enterprise Server Edition 10.5
v IBM WebSphere Application Server Network Deployment 8.5
v IBM WebSphere MQ 7.5
v IBM Integration Bus 9.0
v IBM Integration Bus Manufacturing Pack for Enterprise 1.0
v IBM Installation Manager and Packaging Utility for the Rational® Software

Development Platform 1.6
v IBM Infosphere Master Data Management Collaboration Server - Collaborative

Edition for Non-Financial Services 11.4
v IBM ILOG® CPLEX® Optimization Studio 12.6
v IBM SPSS Analytic Server 1.0

Supporting programs - Client installation
v IBM Cognos Framework Manager 10.2
v IBM Cognos Lifecycle Manager 10.2
v IBM Cognos for Microsoft Office 10.2
v IBM Cognos Dynamic Query Analyzer 10.2
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v IBM SPSS Statistics Client / Developer Documentation 22.0
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Appendix F. Programs not authorized by the IBM Predictive
Maintenance and Quality license

The following programs are not authorized with the IBM Predictive Maintenance
and Quality, and the use of these programs is not authorized by the Predictive
Maintenance and Quality license.

IBM Cognos Analysis for Microsoft Excel (IBM Cognos Business Intelligence
Analytic Administrator 10.2.2)

IBM Cognos Analysis Studio (of IBM Cognos Business Intelligence Analytic
Administrator 10.2.2)

IBM Cognos Business Intelligence Transformer (of IBM Cognos Business
Intelligence Analytic Administrator 10.2.2)

IBM Cognos Connection Installer for IBM Cognos Insight (of IBM Cognos Business
Intelligence Analytic Administrator 10.2.2)

IBM Cognos Cube Designer (of IBM Cognos Business Intelligence Analytic
Administrator 10.2.2)

IBM Cognos Data Manager Connector (of IBM Cognos Business Intelligence
Analytic Administrator 10.2.2)

IBM Cognos Insight (of IBM Cognos Business Intelligence Analytic Administrator
10.2.2)

IBM Cognos Metric Designer (of IBM Cognos Business Intelligence Analytic
Administrator 10.2.2)

IBM Cognos Metric Studio (of IBM Cognos Business Intelligence Analytic
Administrator 10.2.2)

IBM Cognos Metrics Manager (of IBM Cognos Business Intelligence Analytic
Administrator 10.2.2)

IBM Cognos Query Studio (of IBM Cognos Business Intelligence Analytic
Administrator 10.2.2)

IBM Cognos TM1® Package Connector (of IBM Cognos Business Intelligence
Analytic Administrator 10.2.2)

IBM Connections (of IBM Cognos Business Intelligence Analytic Administrator
10.2.2)

IBM DB2 Workgroup Server Edition (of IBM Cognos Business Intelligence Analytic
Administrator 10.2.2)

IBM Tivoli® Directory Integrator Identity Edition (of IBM Cognos Business
Intelligence Analytic Administrator 10.2.2)
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IBM Business Intelligence Pattern 2.2 (of IBM Cognos Business Intelligence
Analytic Administrator 10.2.2)

IBM Business Intelligence Pattern with Blu Acceleration 1.2 (of IBM Cognos
Business Intelligence Analytic Administrator 10.2.2)

IBM Cognos Real-time Monitoring 10.2.2 (of IBM Cognos Business Intelligence
Analytic Administrator 10.2.2)

Embedded version of IBM WebSphere Application Server ("embedded WebSphere
Application Server").6.1 (of IBM Tivoli System Automation for Multiplatforms 3.2
(of IBM DB2 Enterprise Server Edition Version 10.5)))

embedded WebSphere Application Server v7.0 (of IBM Tivoli Directory Server 6.3 -
Client Only (component) (of IBM DB2 Enterprise Server Edition Version 10.5)))

IBM Cloudscape V10 (of IBM Tivoli System Automation for Multiplatforms 3.2 (of
IBM DB2 Enterprise Server Edition Version 10.5)

IBM Data Studio 4.1 (of IBM DB2 Enterprise Server Edition Version 10.5)

IBM DB2 Enterprise Server Edition Version 9.7 (of IBM Tivoli Directory Server 6.3 -
Client Only (component) (of IBM DB2 Enterprise Server Edition Version 10.5)))

pureScale® Feature (of IBM DB2 Enterprise Server Edition Version 10.5)

IBM General Parallel File System (GPFS™) for AIX® 3.5 (of IBM DB2 Enterprise
Server Edition Version 10.5)

IBM General Parallel File System (GPFS) for Linux Multiplatform 3.5 (of IBM DB2
Enterprise Server Edition Version 10.5)

IBM Mobile Database 7.0.1 (of IBM DB2 Enterprise Server Edition Version 10.5 (of
IBM DB2 Enterprise Server Edition Version 10.5))

IBM Mobile Database Sync 1.0 (of IBM DB2 Enterprise Server Edition Version 10.5)

IBM Tivoli Storage Flashcopy Manager 3.2 (of IBM DB2 Enterprise Server Edition
Version 10.5)

IBM Tivoli Storage Flashcopy Manager 4.1 (of IBM DB2 Enterprise Server Edition
Version 10.5)

WebSphere Application Server v7.0 (of IBM Tivoli Directory Server 6.3 - Client
Only (component) (of IBM DB2 Enterprise Server Edition Version 10.5)))

IBM InfoSphere Change Data Capture v7 (of IBM DB2 Enterprise Server Edition
Version 10.5)

IBM InfoSphere Change Data Capture v6.5 (of IBM DB2 Enterprise Server Edition
Version 10.5)

IBM DB2 Connect™ 10.5 (component) (of IBM DB2 Enterprise Server Edition
Version 10.5)
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IBM Cognos Business Intelligence V10.2.1 (of IBM InfoSphere Master Data
Management Collaboration Server - Collaborative Edition for Non-Financial
Services V11.4)

IBM Content Integrator 8.6 (of IBM InfoSphere Master Data Management
Collaboration Server - Collaborative Edition for Non-Financial Services V11.4)

IBM Process Server Standard for Non-production Environment v8.5 (of IBM
InfoSphere Master Data Management Collaboration Server - Collaborative Edition
for Non-Financial Services V11.4)

IBM InfoSphere Data Explorer v9.0 (of IBM InfoSphere Master Data Management
Collaboration Server - Collaborative Edition for Non-Financial Services V11.4)

IBM InfoSphere BigInsights Standard Edition v3.0 (of IBM InfoSphere Master Data
Management Collaboration Server - Collaborative Edition for Non-Financial
Services V11.4)

IBM Integration Bus Healthcare Pack v3.0.0.0 (of IBM InfoSphere Master Data
Management Collaboration Server - Collaborative Edition for Non-Financial
Services V11.4)

IBM InfoSphere Blueprint Director V2.2 (of IBM InfoSphere Master Data
Management Collaboration Server - Collaborative Edition for Non-Financial
Services V11.4)

IBM InfoSphere Information Server v911.3 for Data Quality (of IBM InfoSphere
Master Data Management Collaboration Server - Collaborative Edition for
Non-Financial Services V11.4)

IBM Process Center Standard V8.5 (of IBM InfoSphere Master Data Management
Collaboration Server - Collaborative Edition for Non-Financial Services V11.4)

IBM Process Designer V8.5 (of IBM InfoSphere Master Data Management
Collaboration Server - Collaborative Edition for Non-Financial Services V11.4)

IBM Process Server Standard V8.5 (of IBM InfoSphere Master Data Management
Collaboration Server - Collaborative Edition for Non-Financial Services V11.4)

IBM Security Directory Server v6.3.1 (of IBM InfoSphere Master Data Management
Collaboration Server - Collaborative Edition for Non-Financial Services V11.4)

IBM WebSphere Application Server Base 8.5 (of IBM InfoSphere Master Data
Management Collaboration Server - Collaborative Edition for Non-Financial
Services V11.4)

Workflow engine including Collaboration Areas(of IBM InfoSphere Master Data
Management Collaboration Server - Collaborative Edition for Non-Financial
Services V11.4)

Rational Application Developer for WebSphere Software v8.5 (of IBM InfoSphere
Master Data Management Collaboration Server - Collaborative Edition for
Non-Financial Services V11.4)
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Global Data Synchronization Component (of IBM InfoSphere Master Data
Management Collaboration Server - Collaborative Edition for Non-Financial
Services V11.4)

IBM WebSphere Portal Server 8.5 (of IBM InfoSphere Master Data Management
Collaboration Server - Collaborative Edition for Non-Financial Services V11.4)

J2SE Rule Execution Server (of IBM Integration Bus V9.0)

IBM Integration Bus Manufacturing Pack for Factory v1.0

IBM DB2 Workgroup Server Edition Version 9.7 (of IBM Tivoli Directory Server 6.3
- Client Only (component) (of IBM DB2 Enterprise Server Edition Version 10.5))

IBM WebSphere Application Server Developer Tools for Eclipse (of IBM WebSphere
Application Server Network Deployment V8.5.5)

IBM WebSphere eXtreme Scale (of IBM WebSphere Application Server Network
Deployment V8.5.5)
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Appendix G. Administration tool and product portal reference

The administrative tools and portals for IBM Predictive Maintenance and Quality
are located in several locations.

Access information for the tools and portals is provided in the following table.

Table 32. Administration tool and product portal reference for a multiple-server installation

Administration tool or portal
and description URL or location

WebSphere Integrated
Solutions Console

The WebSphere Integrated
Solutions Console is the
administration tool for
WebSphere.

The WebSphere Integrated
Solutions Console is running
on each node computer where
WebSphere is installed.

Use the console to start and
stop applications.

http://server_node_name:9060/ibm/console

Where server_node_name is the name or IP address of a
node computer where WebSphere is installed.

Leave the User ID box blank.

IBM Cognos Configuration

Use IBM Cognos
Configuration to configure
settings for IBM Cognos
Business Intelligence.

/opt/IBM/cognos/c10_64/bin64/cogconfig.sh

IBM Cognos Configuration is installed on the Business
Intelligence (BI) node computer.

IBM Cognos Connection

Use IBM Cognos Connection
to access reports.

IBM Cognos Administration

Use IBM Cognos
Administration to configure
IBM Cognos BI, such as add
data source connections and
set security.

http://bi_node_name/ibmcognos/

Where bi_node_name is the name or IP address of BI node
computer.

IBM SPSS Collaboration and
Deployment Services
Deployment Manager

Use IBM SPSS Collaboration
and Deployment Services
Deployment Manager to
configure IBM SPSS server
settings.

http://analytics_node_name:9080/config

Where analytics_node_name is the name or IP address of
Predictive Analytics node computer.

The default user name is admin.

The default password is admin.
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Table 32. Administration tool and product portal reference for a multiple-server
installation (continued)

Administration tool or portal
and description URL or location

IBM InfoSphere Master Data
Management Collaboration
Server

http://mdm_node_name:7507

Where mdm_node_name is the name or IP address of Master
Data Management (MDM) node computer.

The default user name is Admin. This value is case
sensitive.

The default password is trinitron. This value is case
sensitive.

You must also enter a company name. The default
company name is IBMPMQ.

Table 33. Administration tool and product portal reference for a single-server installation

Administration tool or portal
and description URL or location

WebSphere Integrated
Solutions Console

The WebSphere Integrated
Solutions Console is the
administration tool for
WebSphere.

The WebSphere Integrated
Solutions Console is running
on each node computer where
WebSphere is installed.

Use the console to start and
stop applications.

http://server_node_name:9060/ibm/console

Where server_node_name is the name or IP address of a
node computer where WebSphere is installed.

Leave the User ID box blank.

IBM Cognos Configuration

Use IBM Cognos
Configuration to configure
settings for IBM Cognos
Business Intelligence.

/opt/IBM/cognos/c10_64/bin64/cogconfig.sh

IBM Cognos Configuration is installed on the Business
Intelligence (BI) node computer.

IBM Cognos Connection

Use IBM Cognos Connection
to access reports.

IBM Cognos Administration

Use IBM Cognos
Administration to configure
IBM Cognos BI, such as add
data source connections and
set security.

http://bi_node_name/ibmcognos/

Where bi_node_name is the name or IP address of BI node
computer.
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Table 33. Administration tool and product portal reference for a single-server
installation (continued)

Administration tool or portal
and description URL or location

IBM SPSS Collaboration and
Deployment Services
Deployment Manager

Use IBM SPSS Collaboration
and Deployment Services
Deployment Manager to
configure IBM SPSS server
settings.

http://analytics_node_name:9082/config

Where analytics_node_name is the name or IP address of
Predictive Analytics node computer.

The default user name is admin.

The default password is admin.

IBM InfoSphere Master Data
Management Collaboration
Server

http://mdm_node_name:7507

Where mdm_node_name is the name or IP address of Master
Data Management (MDM) node computer.

The default user name is Admin. This value is case
sensitive.

The default password is trinitron. This value is case
sensitive.

You must also enter a company name. The default
company name is IBMPMQ.

Default users for an express deployment
The following user names and passwords are used in an express deployment of
IBM Predictive Maintenance and Quality.
v On the data node computer:

– The IBM DB2 administrative user name is dasusr1. The password is dasusr1.
– The IBM DB2 instance owner user name is db2inst1. The password is

db2inst1.
– The IBM DB2 fenced user name is db2fenc1. The password is db2fenc1.

v On the Master Data Management (MDM) node computer:
– The WebSphere Application Server administrative user name is admin. The

password is admin.
v On the Analytics node computer:

– The SPSS user name is admin. The password is admin.
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Notices

This information was developed for products and services offered worldwide.

This material may be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. This document may
describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
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Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
200 W. Madison St.
Chicago, IL
60606
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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This Software Offering does not use cookies or other technologies to collect
personally identifiable information.

Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “ Copyright and
trademark information ” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:
v Microsoft, Windows, Windows NT, and the Windows logo are trademarks of

Microsoft Corporation in the United States, other countries, or both.
v Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,

Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

v Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

v UNIX is a registered trademark of The Open Group in the United States and
other countries.

v Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
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